
M211850EN-H
CONFIDENTIAL

Administrator Guide
IRIS Focus
Version 5.3



PUBLISHED BY

Vaisala Oyj
Vanha Nurmijärventie 21, FI-01670 Vantaa, Finland
P.O. Box 26, FI-00421 Helsinki, Finland
+358 9 8949 1

Visit our Internet pages at www.vaisala.com.

© Vaisala 2020

No part of this document may be
reproduced, published or publicly
displayed in any form or by any means,
electronic or mechanical (including
photocopying), nor may its contents be
modified, translated, adapted, sold or
disclosed to a third party without prior
written permission of the copyright holder.
Translated documents and translated
portions of multilingual documents are
based on the original English versions. In
ambiguous cases, the English versions are
applicable, not the translations.

The contents of this document are subject
to change without prior notice.

Local rules and regulations may vary and
they shall take precedence over the
information contained in this document.
Vaisala makes no representations on this
document’s compliance with the local
rules and regulations applicable at any
given time, and hereby disclaims any and
all responsibilities related thereto.

This document does not create any legally
binding obligations for Vaisala towards
customers or end users. All legally binding

obligations and agreements are included
exclusively in the applicable supply
contract or the General Conditions of Sale
and General Conditions of Service of
Vaisala.
This product contains software developed
by Vaisala or third parties. Use of the
software is governed by license terms and
conditions included in the applicable
supply contract or, in the absence of
separate license terms and conditions, by
the General License Conditions of Vaisala
Group.
This product may contain open source
software (OSS) components. In the event
this product contains OSS components,
then such OSS is governed by the terms
and conditions of the applicable OSS
licenses, and you are bound by the terms
and conditions of such licenses in
connection with your use and distribution
of the OSS in this product. Applicable OSS
licenses are included in the product itself
or provided to you on any other applicable
media, depending on each individual
product and the product items delivered
to you.

http://www.vaisala.com/


Table of contents

1. About This Document................................................................................... 7
1.1 Version information.......................................................................................... 7
1.2 Related documents...........................................................................................7
1.3 Trademarks........................................................................................................ 7
1.4 Documentation conventions........................................................................... 8

2. IRIS Focus Overview......................................................................................9
2.1 IRIS Product Family.........................................................................................10
2.2 Licensing............................................................................................................11

3. Requirements.................................................................................................. 13
3.1 IRIS Focus Hardware Requirements..............................................................13
3.2 Software Requirements.................................................................................. 13
3.3 Network Requirements................................................................................... 15
3.4 Data Manager Disk Space Requirements..................................................... 15

4. IRIS Focus Architecture.............................................................................. 17
4.1 Map Layers........................................................................................................17
4.2 GeoServer and Maps....................................................................................... 19
4.3 On-demand Radar Products.........................................................................20
4.4 IRIS Analysis Radar Products......................................................................... 21
4.5 Lightning Layer............................................................................................... 22
4.6 Web Application............................................................................................. 23

5. Installation....................................................................................................... 24
5.1 Downloading Installation Packages............................................................. 24

5.1.1 Verifying MD5 hashes............................................................................. 25
5.2 Prerequisites for Installation......................................................................... 25
5.3 Installing CentOS............................................................................................ 26

5.3.1 Setting the Root Password.................................................................... 34
5.3.2 Creating CentOS User Accounts and Finalizing the Installation....... 35

5.4 Installing IRIS Focus from a USB stick..........................................................35
5.5 Installing IRIS Focus patch.............................................................................37
5.6 Installing IRIS Focus Components................................................................37
5.7 Running OS Hardening Scripts..................................................................... 39
5.8 Activating License..........................................................................................40

5.8.1 Activating the License from a USB Locking Device........................... 40
5.8.2 Activating License – Online.....................................................................41
5.8.3 Activating License – Offline...................................................................44

5.9 Configuring IRIS for IRIS Focus.................................................................... 46
5.9.1 Setting or Changing the Socket Server................................................46
5.9.2 Activating the Socket Server in IRIS Radar..........................................47
5.9.3 Setting up Data Manager....................................................................... 47

5.10 Verifying IRIS Focus Installation................................................................... 53

Table of contents

CONFIDENTIAL 1



6. One-server Installation of IRIS Focus and IRIS Analysis..............54
6.1 Configuring IRIS for IRIS Focus in One-server Installation........................55

6.1.1 Setting up Data Manager on IRIS Analysis Server.............................. 55

7. Configuration................................................................................................. 59
7.1 Adding/Removing Radars.............................................................................59
7.2 Starting and stopping the Nowcast server................................................. 59

7.2.1 Enabling the Nowcast Server................................................................ 59
7.2.2 Starting the Nowcast Server................................................................. 60
7.2.3 Stopping the Nowcast Server.................................................................61
7.2.4 Restarting the Nowcast Server...............................................................61

7.3 Setting up housekeeping for events and alerts database..........................61
7.4 Configuring visualization of hybrid tasks....................................................62
7.5 Enabling Lightning Layer...............................................................................63
7.6 Scheduling Image Exports from IRIS Focus............................................... 64
7.7 Importing Historical Data to IRIS Focus...................................................... 66

8. System Administration............................................................................... 67
8.1 User roles.........................................................................................................67

8.1.1 Managing User Accounts....................................................................... 68
8.1.2 Creating User Accounts After First Install............................................68
8.1.3 Removing User Accounts........................................................................ 71
8.1.4 Unlocking administrator account........................................................... 71

8.2 Managing Organizations.................................................................................71
8.3 Map Management........................................................................................... 72

8.3.1 Adding and Editing Map Layers.............................................................72
8.3.2 Map View Context................................................................................... 73
8.3.3 Adding external map layers................................................................... 74

8.4 systemd............................................................................................................76
8.5 Monit................................................................................................................ 76
8.6 HAProxy...........................................................................................................76
8.7 IRIS Focus Web Application..........................................................................76
8.8 GeoServer........................................................................................................76
8.9 Data Manager..................................................................................................77

8.9.1 Setting-up Dataflow Alerts.................................................................... 77
8.9.2 Viewing Dataflow Alerts.........................................................................79
8.9.3 Setting Up Data Manager Housekeeping Service............................... 79
8.9.4 Running Data Manager Clear Data Script............................................80

8.10 Stopping, Starting, and Restarting Services...............................................80
8.11 Logging.............................................................................................................81

8.11.1 Reading System Service Logs.................................................................81
8.11.2 Reading Nowcast Server Logs................................................................81

8.12 Installing a CA Certificate.............................................................................. 82
8.13 Backing-up System Configuration............................................................... 83

8.13.1 Making a Manual Back-up...................................................................... 83
8.14 Restoring from Backup..................................................................................83
8.15 Server Management Software...................................................................... 85
8.16 Licensing on Server Restart.......................................................................... 85

Version 5.3 Administrator Guide M211850EN-H

2 CONFIDENTIAL



8.17 Licensing on Systems with Mirrored HDDs (RAID 1 or RAID 5)................86
8.18 Reactivating the License After Server Upgrade.........................................86

9. Upgrade............................................................................................................ 87
9.1 Upgrading IRIS Focus 4.0 or later to IRIS Focus 5.x.x................................87

9.1.1 License......................................................................................................87
9.1.2 Running the upgrade..............................................................................88

9.2 Upgrading IRIS Focus 4.0 or 5.0 to IRIS Focus 5.1..................................... 90
9.3 Preparing to Upgrade to IRIS Focus 3.0 to IRIS Focus 4.0.........................91
9.4 Upgrading IRIS Focus 3.0 to IRIS Focus 4.0............................................... 93
9.5 Upgrading IRIS Focus 2.1 to IRIS Focus 3.0.................................................95
9.6 Upgrading IRIS Focus 2.0 to IRIS Focus 2.1.................................................96

10. Security.............................................................................................................98
10.1 Encryption.......................................................................................................98
10.2 Certificates...................................................................................................... 98
10.3 Security Settings............................................................................................ 98

11. Troubleshooting..........................................................................................100
11.1 Data Manager Does Not Work as Expected..............................................100
11.2 Data Manager Housekeeping Not Working As Expected.........................101
11.3 Identifying IRIS Focus Software Version....................................................102
11.4 Lightning Layer Empty.................................................................................102
11.5 Lightning Layer Missing............................................................................... 102
11.6 Nowcasting is Unavailable...........................................................................104
11.7 Taking a Snapshot Gives Server Error........................................................ 105
11.8 Online help does not display correctly in Internet Explorer....................106
11.9 Uninstalling IRIS Focus................................................................................ 106

Appendix A: File Locations........................................................................ 107

Appendix B: Map Layer Configuration Options.................................... 108

Appendix C: Nowcasting Configuration Files.........................................110
C.1. nowcast.ini...................................................................................................... 110
C.2. vsoweb-override.ini....................................................................................... 112

Glossary.............................................................................................................115

Index.................................................................................................................. 119

Warranty...........................................................................................................123

Technical support...........................................................................................123

Recycling..........................................................................................................123

Table of contents

CONFIDENTIAL 3



List of figures

Figure 1 IRIS Focus Main View........................................................................................ 9
Figure 2 IRIS Focus Data Flow.......................................................................................10
Figure 3 Generating On-Demand IRIS Products.......................................................14
Figure 4 IRIS Focus Architecture................................................................................... 17
Figure 5 IRIS Focus Product Layers..............................................................................18
Figure 6 Base Map From GeoServer.............................................................................19
Figure 7 On-demand Product Components............................................................. 20
Figure 8 Visualized Radar Product ............................................................................. 20
Figure 9 IRIS Analysis Product Data Flow to IRIS Focus.........................................21
Figure 10 On-demand and IRIS Analysis Product Settings.....................................22
Figure 11 Lightning Layer and Controls....................................................................... 22
Figure 12 IRIS Focus Delivery Options..........................................................................24
Figure 13 Creating User Accounts..................................................................................35
Figure 14 IRIS Radar Status Menu..................................................................................47
Figure 15 Radar Data Delivery Paths............................................................................ 48
Figure 16 Editing the Map Context.................................................................................74

Version 5.3 Administrator Guide M211850EN-H

4 CONFIDENTIAL



List of tables

Table 1 Document versions (English)............................................................................7
Table 2 Related documents..............................................................................................7
Table 3 Hardware Requirements................................................................................... 13
Table 4 IRIS Network Requirements............................................................................. 15
Table 5 Approximate Required Disk Space Examples for an IRIS

RAW File of 0.01  GB.......................................................................................... 15
Table 6 Vaisala-recommended disk partitioning..................................................... 26
Table 7 IRIS Focus Services............................................................................................38
Table 8 IRIS Focus Users................................................................................................. 38
Table 9 Hardened Areas..................................................................................................39
Table 10 Vaisala-recommended disk partitioning..................................................... 54
Table 11 IRIS Focus User Roles....................................................................................... 67
Table 12 Data Manager Services..................................................................................... 77
Table 13 IRIS Focus Application and Configuration Files.......................................107
Table 14 Map Layer Configuration Options................................................................108

List of tables

CONFIDENTIAL 5



Version 5.3 Administrator Guide M211850EN-H

6 CONFIDENTIAL



1. About This Document

1.1 Version information
This document provides information for installing, operating, and maintaining IRIS Focus
software.

Table 1 Document versions (English)

Document code Date Description

M211850EN-H July 2020 Eighth version of this document. For release 5.3.

M211850EN-G April 2019 Seventh version of this document. For release 5.1.

M211850EN-F August 2018 Sixth version of this document.

1.2 Related documents

Table 2 Related documents

Document code Name

M211850EN IRIS Focus Administrator Guide

M211849EN IRIS Focus User Guide

M211904EN IRIS Focus Release Notes

M211315EN IRIS and RDA Software Installation Guide

1.3 Trademarks

HydroClass™ is a trademark of Vaisala Oyj.

IRIS™ is a trademark of Vaisala Oyj.

Vaisalaâ is a registered trademark of Vaisala Oyj.

Chrome™ is a trademark of Google Inc.

Firefoxâ is a registered trademark of Mozilla Foundation.

Edge™ is a trademark of Microsoft Corporation in the United States and other countries.

All other product or company names that may be mentioned in this publication are trade
names, trademarks, or registered trademarks of their respective owners.

Chapter 1 – About This Document

CONFIDENTIAL 7



1.4 Documentation conventions

Warning alerts you to a serious hazard. If you do not read and
follow instructions carefully at this point, there is a risk of injury or even death.
WARNING!

Caution warns you of a potential hazard. If you do not read and
follow instructions carefully at this point, the product could be damaged or
important data could be lost.

CAUTION!

Note highlights important information on using the product.

Tip gives information for using the product more efficiently.

Lists tools needed to perform the task.

Indicates that you need to take some notes during the task.
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2. IRIS Focus Overview

Figure 1 IRIS Focus Main View

IRIS Focus provides user-friendly, browser-based tools for viewing and analyzing weather data
received from weather radars.

Weather data is overlaid on a geographical map that is centered on a selected radar site or
composite site. Data is gathered from a single weather radar or a network of radar sites.

With the zoomable animation timeline, users can easily visualize and animate current,
nowcasted, or historical data.

Nowcasting performs advection calculations on motion data from radar products to predict
weather movement and severity up to 2 hours in the future.

Significant weather events such as hail, wind shear, or heavy rain are automatically detected
when they enter an area of interest.

Radar Products

The displayed data typically consists of radar products. Radar products are raw signal data
from a radar receiver processed to provide information about current weather conditions.

Radar products measure information such as radar signal reflectivity or rain intensity for
analysis by meteorologists.
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On-demand radar products On-demand products are based on raw data from the IRIS back-
end. IRIS Focus reads raw volume data and generates radar
products in real time.

On-demand products provide control over the presentation of
weather data in the IRIS Focus user interface. For example, users
can change the reflectivity threshold of a selected radar product
on the fly.

IRIS Focus users can create composites of on-demand products
by selecting multiple radar sites from the radar site selector.

IRIS Analysis radar products IRIS Analysis radar products are configured and produced in IRIS
Analysis and displayed by IRIS Focus on request.

More information

‣ On-demand Radar Products (page 20)
‣ IRIS Analysis Radar Products (page 21)

2.1 IRIS Product Family
IRIS provides an intuitive user experience for professional users, such as meteorologists and
analysts. It is closely integrated with Vaisala weather radar systems, where IRIS Focus forms
the visualization front-end and other IRIS components handle radar control, radar product
generation, and data distribution.

IRIS Focus runs on a web server that users can connect to in an enterprise intranet or from an
external location or the Internet. Network connections between IRIS Focus and the data
processing back-end go through a socket server, a custom protocol over TCP/IP that delivers
radar data from the IRIS back-end services to IRIS Focus. IRIS Focus polls the server for data
and displays it on screen using the browser.

The following figure shows a setup where IRIS Focus is used as part of a complete Vaisala
weather radar network consisting of 2 radar sites.

Figure 2 IRIS Focus Data Flow
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In this case, IRIS Analysis and IRIS Radar can be considered back-end services for the IRIS
Focus front-end interface. IRIS Focus communicates with IRIS Analysis through a socket server
connection.

The components have the following functions:

• IRIS Radar - Operates the radar site and stores data gathered from the radar signals in
RAW format.

• IRIS Analysis - Receives RAW data from IRIS Radar through secure connection and
processes it into displayable radar products.

• IRIS Focus - Polls pre-configured radar products from IRIS Analysis and displays them on
the web interface and generates on-demand radar products from RAW data.

2.2 Licensing
IRIS Focus requires a software license to run. To activate the license, you need a product key.

Vaisala delivers the product key when you purchase the software. If you have purchased the
software and you have not received the product key, please contact Vaisala.

For server deliveries, Vaisala activates the product key in the factory, and a Vaisala
representative sends you the key for future reference.

The license is mapped to the hardware of your IRIS Focus server. If your hardware
configuration changes and you need to re-install IRIS Focus, you must request a replacement
license from your Vaisala representative, unless you have a USB license key.

If you have a USB license key, IRIS Focus runs when the USB drive is inserted in the server. If
you install IRIS Focus on another server, you can move the USB license key to that server.

To view information about the license version, login to IRIS Focus as admin, and select Admin 
> System > Licensing Management.

License Options

The IRIS Focus license includes the following:

• IRIS Focus Light
IRIS Focus Light has an unlimited number of seats and provides access to the map view.
If the license is missing, users cannot log in while admins can log in but cannot access the
map view.

• IRIS Focus
The IRIS Focus license is required to use IRIS Focus features and products.
IRIS Focus licensing is based on a floating seat pool.

• Nowcasting
The optional nowcasting feature requires a separate license in addition to an IRIS Focus
license.

Chapter 2 – IRIS Focus Overview
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IRIS Focus Seat-based License

IRIS Focus licenses are available in different configurations. To increase your seat count, you
must replace the current license with a new one by contacting your Vaisala representative.

The seat count defines how many users can access IRIS Focus at the same time. When a user
logs in, they occupy a seat. When a user logs out, the seat is released and the next user can
take it. If a user logs in when all the licenses are reserved, the user is shown IRIS Focus Light
until an IRIS Focus license is released.

Nowcasting is only available to users with an IRIS Focus seat and nowcasting license.

Seat counts within a workstation are browser-based. For one license reservation, users may
view IRIS Focus in as many instances or tabs of one browser, such as Firefoxâ, as they like. If a

user opens IRIS Focus in a different browser, such as Google Chrome™, they reserve one
license for each browser.

More information

‣ User roles (page 67)
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3. Requirements

3.1 IRIS Focus Hardware Requirements

Table 3 Hardware Requirements

Minimum Recommended1)

• Modern 4-core CPU (Intel Xeon E5 series or
similar)

• 16 GB RAM
• 1 TB HDD
• 1400 x 1050 minimum screen resolution

• Modern 8-core CPU (Intel Xeon E5 series or
similar)

• 32 GB RAM
• 2x 1 SAS TB HDD in RAID 1 configuration
• 1920 x 1200 screen resolution

1) The pre-installed IRIS Focus system delivery option uses the Dell PowerEdge R440 rack
server unit, which meets the recommended hardware setup. See the Dell product data sheet
for full specifications.

The hardware capacity directly affects the performance of IRIS Focus. Multiple users can be
logged in to IRIS Focus, and each user can have multiple weather and terrain layers rendered
on screen at the same time. Each weather and terrain layer requires some resources from the
system.

For optimal performance, Vaisala recommends running IRIS Focus on a dedicated hardware
server and not in a virtualized environment.

3.2 Software Requirements

IRIS Focus supports current Microsoft Edgeâ, Mozilla Firefoxâ, and Google Chrome™

browsers.

Before installing IRIS Focus, your environment must meet the following software requirements.

IRIS Network

IRIS network, such as an IRIS Analysis instance must be configured correctly to make data
from at least one radar site available for IRIS Focus.

CentOS 7.x

CentOS 7.1 or later DVD/ISO image mounted on your server (offline installation) or a functional
internet connection (online installation).

The installation script verifies the version of several core system packages during the
installation and updates them from the mounted media or Internet.

Chapter 3 – Requirements
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This version of IRIS Focus has been tested with CentOS 7.4 and 7.6. We expect
IRIS Focus to also work with other versions of CentOS 7.x.

IRIS Analysis

The IRIS Analysis server provides radar products through a proprietary socket server
connection. The socket server connection is enabled if at least one radar is connected to your
IRIS Analysis server, at least one product is configured and generated in IRIS Analysis, and the
IRIS Analysis server has IRIS software version 8.13.6 or newer installed. No further
configuration is needed.

The map projection in the IRIS Focus web application depends on having a single radar or a
group of radar sites to act as a center point to for map rendering.

In most IRIS Focus configurations, the radar product generator is an IRIS Analysis server that
has been set up earlier on the radar site. For more information, please contact Vaisala.

For information on configuring IRIS Analysis, see IRIS and RDA Software Installation Guide.

Before beginning the IRIS Focus installation, make sure you know the hostname
of your socket server.

Data Manager

Radar volume data is fetched from the data manager interface and processed to on-demand
radar products in the IRIS Focus application.

The data manager does not need to be active during installation.

Figure 3 Generating On-Demand IRIS Products

More information

‣ Setting up Data Manager (page 47)
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3.3 Network Requirements

Table 4 IRIS Network Requirements

Item Specification

Communication from IRIS Analysis to IRIS Focus

Network data transfer >100 Mbit/s (1000 Mbit/s recommended)

Communication from IRIS Focus to IRIS Analysis

Single user (1 seat) Network data transfer > 450 kbit/s

Latency ~150 ms

Multiple simultaneous users 5 seats > 2.5 Mbit/s

10 seats > 5 Mbit/s

20 seats > 10 Mbit/s

3.4 Data Manager Disk Space Requirements
The amount of radar data generated depends on a number of variables, including, for example:

• Size of the RAW files as determined by factors such as radar scan strategy, range, number
of recorded data, and the amount of precipitation

• Number of radars in the network
• Amount of disk space reserved for the partition where data manager stores the data

Use the following formula to calculate the approximate disk space required for data manager
to store data collected over a certain time period:

totalDiskSpace GB = 400+ (scanSize GB * numberOfRadars * (1440/ 
scanIntervalMinutes) * daysOfData)

Table 5 Approximate Required Disk Space Examples for an IRIS RAW File of 0.01  GB

Scan Interval (minutes) Number of Radars Days of Data

30 Days 60 Days 1 Year 5 Years 10 Years

5 1 100 GB 500 GB 1 TB 5 TB 10 TB

10 1 50 GB 250 GB 500 GB 2.5 TB 5 TB

5 2 100 GB 1 TB 2 TB 10 TB 20 TB

10 2 100 GB 500 GB 1 TB 5 TB 10 TB

5 5 500 GB 2.5 TB 5 TB 25 TB 50 TB
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Scan Interval (minutes) Number of Radars Days of Data

30 Days 60 Days 1 Year 5 Years 10 Years

10 5 200 GB 1.3 TB 2.6 TB 13 TB 26 TB

5 10 1 TB 5 TB 10 TB 50 TB 100 TB

10 10 500 GB 2.5 TB 5 TB 25 TB 50  TB

More information

‣ Data Manager (page 77)
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4. IRIS Focus Architecture
IRIS Focus reads data in the formats produced by weather radar signal processors.

Usually this data is relayed to IRIS Focus through the signal processing and analysis
component, IRIS Analysis, either as pregenerated radar products or as radar scan source data
files which are processed and displayed as radar products by IRIS Focus.

IRIS Focus only accepts a single data source as its socket server. IRIS Analysis can be
connected to an unlimited number of radar sites and relay their radar products to IRIS Focus.

Figure 4 IRIS Focus Architecture

Each radar product is displayed on top of a map view, which is rendered by a GeoServer
instance that is installed during the IRIS Focus installation. The map terrain and detail layers
are always on the background, and the radar products are drawn on top of them. The user can
change the order of radar product layers in real-time.

IRIS Focus can also display data received through WMS protocol, for example, lightning data
and satellite data. These are also displayed as a layer over the map layer.

Most radar products have editable color scales. Color scales are stored as JSON objects on the
IRIS Focus server and can be reused.

4.1 Map Layers
The background map and the weather data visualizations from the radar products are drawn
as individual layers and then combined to form an overview of current weather conditions
around the radar site.

You can also view WMS layers from external sources, such as satellite image layers, as layers on
the map.

Chapter 4 – IRIS Focus Architecture
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Figure 5 IRIS Focus Product Layers

Base Layers

The background (also known as base) consists of a number of non-interactive layers. At the
bottom is a terrain map that can be enhanced with additional layers containing roads, province
boundaries, and other similar terrain features.

Radar Product Layers

The interactive radar product layers (1 to 4) are drawn on top of the background layers.

External WMS Layers

WMS layers from external sources, such as satellite images, radar data from an external radar
network, or a lighting layer, can be added to IRIS Focus and viewed on the map exactly like
other radar product layers. Many characteristics of the external product layers, such as the
availability of the color legend, depend on the layer providers.

The external WMS layers are images, and only available in certain projections. To view a WMS
layer on the map view from a certain radar site, the radar site must be configured to use the
same projection as the WMS layer.

For example, if the requested WMS layer is only available in Web Mercator projection, and
the radar site is configured in azimuthal equidistant projection, the WMS layer will not be
shown.

IRIS Focus supports both WMS and WMS-T layers. WMS-T layers are layers with time
parameters included in the request.
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4.2 GeoServer and Maps
The map engine in IRIS Focus uses GeoServer architecture. When reading data from a single
radar site, GeoServer renders the map using Azimuthal Equidistant projection, which means
that all directions and distances are correct when measured from the point of origin, which is
the radar site in this case. When reading data from a composite of multiple radar sites, Web
Mercator projection is used.

The terrain data in IRIS Focus consists of a detailed vector map of Earth, separated into
multiple layers. The base map content is licensed from the collaborative OpenStreetMap
project, which provides all vector shapefiles for the base terrain.

Figure 6 Base Map From GeoServer

To save system resources, the shapefiles are combined into different map detail levels that are
rendered as a single layer where possible. For example, selecting the Full detail map level does
not draw separate layers for terrain, roads, map labels, and other map features. Instead, all the
content has been precompiled into a single layer in the IRIS Focus map package and then
drawn on screen.

When a user opens the map view in IRIS Focus, GeoServer processes the vector data in the
current view area into 256x256 PNG tiles that are displayed in the browser window. New tiles
are calculated and generated every time the user pans or zooms on the map, so moving on the
map may feel a bit sluggish in the beginning. To improve performance, GeoServer runs a
caching component called GeoWebCache that stores the tiles for faster retrieval in the future.

GeoServer has a management web interface that runs at http://localhost:34180/
geoserver. The default management account name is admin and the password can be found
in the file /etc/vaisala/radarsw/configuration/gis-override.ini. The
password is generated automatically during IRIS Focus installation.

The base map data is stored in a PostgreSQL database, which also stores all web application
data.

Chapter 4 – IRIS Focus Architecture
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4.3 On-demand Radar Products
When displaying on-demand radar products, IRIS Focus fetches raw radar measurement data
from the back-end and processes it in real-time. This provides hands-on control over the radar
product parameters.

The full raw radar volume data is stored and can also be used later for on-demand product
generation.

Figure 7 On-demand Product Components

Data for on-demand products comes from the RAW format files produced by the IRIS backend.

IRIS Focus reads the RAW data through the data manager.

When you select an on-demand radar product in IRIS Focus, the web application accesses the
database and fetches the required data, not only for the current situation but for the whole
recorded segment. The data is then processed and displayed in IRIS Focus.

Figure 8 Visualized Radar Product
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More information

‣ Data Manager (page 77)

4.4 IRIS Analysis Radar Products
IRIS Analysis radar products are generated by signal processing components in IRIS Analysis.
IRIS Focus reads the list of products, and allows you to select which one to display on the IRIS
Focus map view.

The radar products and their settings are pre-configured, and only displayed in IRIS Focus.
They cannot be edited in the IRIS Focus map view.

There is no upper limit to the number of pre-configured radar products that IRIS Focus can
have.

The raw volume data is stored on a IRIS Analysis machine. The data can be archived to tape or
stored on a large disk array.

Figure 9 IRIS Analysis Product Data Flow to IRIS Focus

The radar products are rasterized into 2D bitmap images, based on the back-end signal
processing settings. The images are sent to the IRIS Focus web user interface through the IRIS
Socket Server interface. The Socket Server uses TCP port 30735 to communicate with IRIS
Focus.

When you select a pre-configured product in IRIS Focus, IRIS Focus polls the Socket Server
and loads the image.

The resolution of pre-configured radar products is limited by the capacity of the processing
module that produces them. For example, IRIS Analysis has the following limitations:

• Max number of bins in any ray at any time: 4200
• Max number of rays in a sweep: 1024
• Max number of moments recorded in a sweep: 16
• Max number of sweeps per scan: 40

For information on setting up IRIS Analysis products, see IRIS Product and Display Guide.
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Figure 10 On-demand and IRIS Analysis Product Settings

4.5 Lightning Layer
Vaisala offers an optional subscription service for the Vaisala Global Lightning Dataset
GLD360. GLD360 is a dedicated data stream that measures lightning strikes from the surface
of the Earth, and its data is generated outside IRIS Focus.

GLD360 can be integrated with IRIS Focus and included as an additional WMS lightning layer
in the web UI, where the user can view it just like radar product layers.

Figure 11 Lightning Layer and Controls
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To take the lightning layer into use, the IRIS Focus server must be online and your organization
must have an active subscription to GLD360 data. For information on subscribing to GLD360
data, contact Vaisala Lightning Data Services.

More information

‣ Enabling Lightning Layer (page 63)

4.6 Web Application

IRIS Focus supports current Microsoft Edgeâ, Mozilla Firefoxâ, and Google Chrome™

browsers.

IRIS Focus only accepts HTTPS connections. All requests to the standard HTTP port are
redirected to the HTTPS port 443.

All application settings are stored in a PostgreSQL database on the IRIS Focus server.

Map and terrain data are stored in the same database.

More information

‣ Installing a CA Certificate (page 82)
‣ Certificates (page 98)
‣ Encryption (page 98)
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5. Installation

Figure 12 IRIS Focus Delivery Options

Option A Pre-installed system delivery from Vaisala. The "turnkey" option. Place an order
and wait for delivery by Vaisala.

Option B Preconfigured USB stick containing the CentOS operating system and all required
files for installing IRIS Focus.

Option C Downloadable installation packages. Download the required packages to install
IRIS Focus on your server.

5.1 Downloading Installation Packages

1. Connect to Vaisala Sigmet server (ftp://ftp.sigmet.com) using an FTP client. 
The host server allows read access for anonymous FTP connections.
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2. Navigate to /outgoing/releases/Focus/<latest version>
3. Download the following files: 

The files are very large. Use a download tool such as CrossFTP that allows
resuming downloads to fetch the packages.

a. IRIS Focus web application package: Vaisala_IRIS_installer-<latest
version>.tar

b. Maps directory: vaisala-iris-maps-v2.zip
c. Terrain data directory: vaisala-iris-terrain-v2.zip

4. If you require the Centos installation image, download it from: 
ftp://ftp.sigmet.com/outgoing/releases/CentOS/7.6/CentOS-7-x86_64-
Everything-1708.iso

You can skip the CentOS installation image if you already have an
appropriately configured CentOS installed.

5.1.1 Verifying MD5 hashes
Each file has an associated md5sum file located in the same download directory.

After downloading the file(s), verify their integrity by checking each file's MD5 hash against
the one provided at the installation site.

1. Do one of the following: 
• In CentOS – Use the pre-installed md5sum command line tool:
md5sum [filename]

• In Microsoft Windows – Use the pre-installed CertUtil utility:
certutil -hashfile [filename] MD5

2. Check that the hashes match completely with the reference hashes at the download
source 
If you see any discrepancies, the downloaded file is likely corrupted.

3. If you see any discrepencies in the hashes, download the mismatching file again.

5.2 Prerequisites for Installation
Before installing IRIS Focus, make sure your environment meets the necessary hardware and
software requirements.
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More information

‣ IRIS Focus Hardware Requirements (page 13)
‣ Software Requirements (page 13)

5.3 Installing CentOS
A prerequisite for installing IRIS Focus is that CentOS is installed on your intended IRIS Focus
system.

This version of IRIS Focus has been tested with CentOS 7.4 and 7.6. We expect
IRIS Focus to also work with other versions of CentOS 7.x.

If you do not have a CentOS system running, select an installation image from Vaisala Sigmet
server (ftp://ftp.sigmet.com/outgoing/releases/centos), and see instructions at Tecmint Linux
Guides (https://www.tecmint.com/centos-7-installation/) on how to perform a CentOS
installation.

Table 6 Vaisala-recommended disk partitioning

Partition Size

/home 50 GB

/boot 500 MB

/var 100 GB

/ 100 GB

swap size of RAM + 2 GB

/srv 50% of the remaining disk space

/usr/iris_data 50% of the remaining disk space

If there is only a little disk space, you can decrease the size of the /home, /var, and /
partitions by 10-20 GB.

When you are only installing IRIS Focus on the server (and not IRIS Analysis), do
not create a /usr/iris_data partition. Instead, allocate all remaining
diskspace to the /srv partition.

Install CentOS according to the standard instructions, with the following changes.

1. Select your installation language.
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2. In DATE & TIME, set the system clock to Coordinated Universal Time (UTC) by choosing
the following values: 

• Region: Etc
• City: Coordinated Universal Time
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3. In SOFTWARE SELECTION, set the server type by selecting the following software
installation options: 

• Base Environment type: Server with GUI 
• Add-ons: Java Platform
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4. In the CentOS installation screen, select NETWORK & HOSTNAME. 

a. Turn the network ON.

b. Select Configure.

c. In the General tab, select Automatically connect to the network when it is available.

d. In the IPv4 Settings tab, select Method > Manual.

e. In the IPv4 Settings tab, select Add to add your network IP address, Netmask,
Gateway, and DNS servers.

f. Select Save.

g. In Host name, type a name for this server.

h. Select Apply.
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5. In INSTALLATION DESTINATION, start manual partitioning: 

a. Select the hard disk.

b. Select I will configure partitioning.

c. Select Done.
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6. Select Click here to create them automatically. 

7. Create the /home partition. 

a. Select the plus (+) icon. 
The ADD A NEW MOUNT POINT dialog appears.

b. Under Desired Capacity, set the size of the home partition (/home) by typing
50 GiB.

c. Select Update Settings.
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8. Create the /var partition:

a. Select the plus (+) icon. 
The ADD A NEW MOUNT POINT dialog appears.

b. In Mount Point, type /var
c. Under Desired Capacity, set the size of the /var partition by typing 100 GiB.

d. Select Add mount point.

9. Select /boot.

a. Under Desired Capacity, set the size of the /boot partition by typing 500 MiB.

b. Select Update Settings.

10. Select /.

a. Under Desired Capacity, set the size of the root partition (/) by typing 100 GiB.

b. Select Update Settings.

11. Select swap.

a. Under Desired Capacity, set the size of the swap to the size that corresponds to RAM
+ 2 GB.

b. Select Update Settings.
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12. Create the /srv partition:

a. Select the plus (+) icon. 
The ADD A NEW MOUNT POINT dialog appears.

b. In Mount Point, type /srv
c. Under Desired Capacity, use the remainder of the server space for the /srv partition

by typing 9999999. 
The user interface fills in the available server space.

d. Select Add mount point.

13. Select Done.
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14. Check that the partitions are defined as follows: 

15. Select Done > Accept Changes.

16. Select Begin Installation.

5.3.1 Setting the Root Password
If your system was pre-installed in Vaisala, the default password is xxxxxxxx.

When you have started the CentOS installation, configure the root and one non-root user
account.

1. Select ROOT PASSWORD. 
The Root Password window opens.

2. Enter your root password. 
Check the password strength meter. While Vaisala recommends a strong password, the
software does not stop you from entering a weak one.

3. In the confirm text box, re-enter your root password.

4. In the upper left hand corner, select Done to return to the main configuration page. 
If your password is weak, you are prompted to select Done a second time.
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5.3.2 Creating CentOS User Accounts and Finalizing the
Installation

1. Select USER CREATION.

2. Create an account with the following properties: 
• User name: radarop
• Password: [chosen password]

Figure 13 Creating User Accounts

3. In the upper left hand corner, select Done to return to the main configuration page. 
If your password is weak, you are prompted to select Done a second time.
The installation continues for a few minutes.

4. When prompted, select Reboot.

5. Select LICENSE INFORMATION. 
Accept the license agreement.

6. Select Done.

7. Select FINISH CONFIGURATION.

The CentOS installation is now complete. You are ready to install IRIS Focus.

5.4 Installing IRIS Focus from a USB stick
In these instructions, x.x is the number of the version/patch.

The IRIS Focus installation USB contains the following file structure for the main version
installation:
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Focus_install
-----vaisala-iris-maps-v2
-----vaisala-iris-terrain-v2
-----Vaisala_IRIS_installer-5.x.x.tar
-----documentation

In the case of a patch release, the USB stick may also include an additional .tar file for the
patch.

To install IRIS Focus from the USB stick, you must copy the files to the CentOS server and
prepare the files for installation.

1. Reboot the system.

2. Log in as root.

3. Insert the USB stick. 
If it is already plugged-in, remove and re-insert the stick.

4. In the pop-up dialog, select Open With Files.

5. Right-click a blank area and select Open in Terminal.

6. In the terminal, type pwd and press ENTER. 
The result is usually /run/media/root/IRIS.

7. Copy the Focus_install directory to the CentOS server: 

mkdir /srv/Focus_install
cp –r /run/media/root/IRIS/Focus_install/* /srv/Focus_install

8. Change to the /Focus_install directory and unpack the .tar file: 

cd /srv/Focus_install
tar -xvf Vaisala_IRIS_installer-5.x.x.tar
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9. Change to the /srv/Focus_install/vaisala-iris-terrain-v2 directory: 

cd /srv/Focus_install/vaisala-iris-terrain-v2

a. Join the fileparts: 

cat vaisala-iris-terrain-v2-part* > vaisala-iris-terrain-v2.zip

b. Unzip the resulting terrain zip file: 

unzip vaisala-iris-terrain-v2.zip

c. Remove the extra files: 

rm -rf vaisala-iris-terrain-v2-part*
rm -rf vaisala-iris-terrain-v2.zip

10. Change to the /Focus_install directory.

11. Run the IRIS Focus installation script: 

/Focus_install/Vaisala-IRIS-Focus-v5.1.0--68/rsw-installer --offline --gis-
db-dump vaisala-iris-maps-v2 --terrain-dir vaisala-iris-terrain-v2 -s 
<hostname or IP of IRIS Analysis socket server>

5.5 Installing IRIS Focus patch
If the delivery includes a separate patch file, first install the main version, and then the patch
file.

1. Log in as root.

2. Copy the patch file Vaisala_IRIS_installer-5.x.x.tar and README.txt from
the USB stick to a temporary directory.

3. Extract the tar file: 

tar -xvf Vaisala_IRIS_installer-5.x.x.tar

4. Follow the instructions in the README.txt to run the upgrade script.

5.6 Installing IRIS Focus Components
The script automatically installs all necessary services, user accounts, and modules required to
run IRIS Focus. The services start automatically.
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Table 7 IRIS Focus Services

Service Description

monit Monitoring tool for Unix
systems and processes.

HAProxy Encodes outgoing traffic with
HTTPS encryption.

vaisala-radarsw-webapp IRIS Focus web application.

vaisala-radarsw-geoserver Map engine for caching and
generating base map layers.

vaisala-radarsw-nowcast-server Nowcasting server.

vaisala-radarsw-data-manager-service Data manager application.

vaisala-radarsw-data-manager-input-service Listener for incoming IRIS RAW
files.

vaisala-radarsw-warn-reader Listener for incoming WARN
products from IRIS Analysis.

Table 8 IRIS Focus Users

User Description

nowcast Restricted user account for running the nowcast service.

radardm Restricted user account for running the data manager
application.

radardminput Restricted user account for running the data manager input
service.

radargeo Restricted user account for running the GeoServer map engine.

radarweb Restricted user account for running the IRIS Focus web
application.

warnreader Restricted user account for running the warn reader service.

1. Make sure you have a CentOS 7 server system set up, and that you have received the IRIS
Focus installation files either as a USB delivery or as a download.

2. Make sure you have the IRIS Focus application installer, map data package, and terrain
data package available. 
These are required because all IRIS Focus components are installed at the same time.

3. Mount the CentOS 7 USB stick or DVD. 
Although CentOS 7 is already set up, the IRIS Focus installer relies on some packages that
are provided by the CentOS repository.

4. Login as root.
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5. Unpack the contents of the IRIS Focus installation file on the server, for example to the /
root/IRIS directory. 
These files occupy approximately 40 Gb of space unpacked.

6. Navigate to the directory where you downloaded the files.

7. Launch the ./rsw-installer script. 
The install script requires the following parameters:

./rsw-installer --offline --gis-db-dump [maps directory] --terrain-dir 
[terrain directory] -s [socket server hostname]

• --gis-db-dump – location for the map data
• --terrain-dir – location for the terrain data
• -s – hostname of the socket server that provides radar product data from IRIS

Analysis

If the computer is connected to the internet, you can run the installer with
the --online flag.
This fetches any additionally required CentOS 7 packages from the internet.

The install process can take a significant amount of time, especially as the
application database is first populated with map data.
Do not abort the installation if you do not see progress in a single step for up to 1
hour.

More information

‣ Security Settings (page 98)
‣ Uninstalling IRIS Focus (page 106)

5.7 Running OS Hardening Scripts
When the IRIS Focus installation is complete, run the OS hardening scripts.

Table 9 Hardened Areas

Hardened Area

Install AIDE (Advanced Intrusion Detection Environment)

Restrict core dumps

Set permissions for grub configuration

Set default Message of the Day

Configure Chrony NTP
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Hardened Area

Configure TCP Wrappers

Strengthen log file permissions

Strengthen Cron configuration

Lockout for failed login attempts

Password suffiency

Strengthen file permissions

Enable SSH issue banner

Disable IPv6

Remove support for unneeded file system types:

cramfs, freevxfs, jffs2, hfs, hfsplus, squashfs, udf, vfat, dccp,sctp, rds, tipc,
cups, avahi-daemon

1. Navigate to the directory where you downloaded the installation files.

2. Type the command: 

./rsw-harden-os 

The command executes the bash scripts in the /release/security-scripts
directory.

5.8 Activating License
IRIS Focus provides several ways to activate the IRIS Focus software license on the server: with
a USB license key, online, or offline without the USB license key.

5.8.1 Activating the License from a USB Locking Device

On Meteo site servers originally provided by Vaisala, the USB locking device
(USB4/ license locking device) is already connected to the USB port on the
motherboard inside the server.

After installing IRIS Focus, you must activate the license by linking the USB locking device to
the license file provided by Vaisala.

For the license to remain active, the USB must remain in the server after completing this
procedure.

1. Insert the USB in the server machine (USB4/ license locking device).

Version 5.3 Administrator Guide M211850EN-H

40 CONFIDENTIAL



2. Install the license with the following command: 

# rsw-install-license /usr/sigmet/config/focus_license.txt

3. Restart the IRIS Focus web application with the following command: 

# systemctl restart vaisala-radarsw-webapp

The license has now been activated on the IRIS Focus server and will remain active as long as
the USB stick is in the server. If you remove the USB from the server, IRIS Focus will not run as
expected. To run IRIS Focus on the server, insert the USB stick again.

If you must replace the server, perform the same procedure on the new server.

5.8.2 Activating License – Online

If you are using a USB license key, first insert the USB drive in the server for the
license to work. See Activating the License from a USB Locking Device (page 40).

1. Login as root.

2. Run the rsw-show-machine-code command on the IRIS Focus server to get the
locking code specific to the server hardware.
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3. Go to Vaisala License Manager Web at https://licensing.vaisala.com and select Product 
Code in the Login Using field. 

4. Enter your product code and select Login.

5. Enter the locking code in the Request Code field. 
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6. Select Generate. 
A popup window with the license string opens.

7. Select Save to File to save the license string to a file on disk. 
The file is saved by default with the name lservrc.

Alternatively, use an SSH client to copy and paste the license string to
a .txt file on the server.

8. Install the license with the rsw-install-license <location-of-the-license-
file> command.

9. Stop and restart the IRIS Focus web application service:

a. Type the command: 

systemctl stop vaisala-radarsw-webapp

b. Wait until the process has stopped and the command prompt is ready for the next
command.

c. Type the command: 

systemctl start vaisala-radarsw-webapp

10. Log in to IRIS Focus using an administrator account.

11. Select Admin > System > Licensing Management to view information about the license
(seats, end date, and start date).
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More information

‣ Licensing (page 11)

5.8.3 Activating License – Offline
If the server running IRIS Focus is not connected to internet, you must activate the license by
entering the IRIS Focus server locking code in Vaisala License Manager Web using an online
computer. Then transfer the license file to the IRIS Focus server.

If you are using a USB license key, first insert the USB drive in the server for the
license to work. See Activating the License from a USB Locking Device (page 40).

1. Run rsw-show-machine-code > [filename] command on the IRIS Focus server
to get the product code specific to the server hardware. 
This stores the product code string in a file.

2. Copy the file to a removable media, such as a USB stick, and transfer it to the online
computer.

3. Go to Vaisala License Manager Web at https://licensing.vaisala.com and select Product 
Code in the Login Using field. 

4. Enter your product code and select Login.
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5. Enter the locking code in the Request Code field. 

6. Select Generate. 
A popup window with the license string opens.

7. Select Save to File to save the license string to a file on disk. 
The file is saved by default with the name lservrc.

Alternatively, use an SSH client to copy and paste the license string to
a .txt file on the server.

8. Copy the license file to a removable media and transport the file to the IRIS Focus server.

9. Install the license with the rsw-install-license <location-of-the-license-
file> command.
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More information

‣ Licensing (page 11)

5.9 Configuring IRIS for IRIS Focus

5.9.1 Setting or Changing the Socket Server
If needed, set or change the socket server:

1. Type the command: 

/usr/vaisala/radarsw/configuration/bin/configure-iris-host 
<socket_server_host_name>
rsw-basemap-site-setup --socket-server <socket_server_host_name>

2. Stop and restart the IRIS Focus web application service:

a. Type the command: 

systemctl stop vaisala-radarsw-webapp

b. Wait until the process has stopped and the command prompt is ready for the next
command.

c. Type the command: 

systemctl start vaisala-radarsw-webapp
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5.9.2 Activating the Socket Server in IRIS Radar

Figure 14 IRIS Radar Status Menu

If your system is running IRIS Focus server, you must enable the IRIS Focus option in IRIS
Radar. For more information, see IRIS Radar User Guide.

1. Make sure IRIS has started.

2. In IRIS Radar, select Menus > Radar Status.

3. Turn on the socket server by selecting the IRIS Focus checkbox. 
When this checkbox is selected, the field shows the status of the socket server process:
Idle, Running, or Stopped.

5.9.3 Setting up Data Manager
The data manager service runs on the IRIS Focus server that receives radar scan volume data,
stored in RAW file format, from the IRIS Analysis server and generates live radar products from
the data in real-time.

During installation, IRIS Focus sets up all necessary services, databases, and user accounts for
processing data. IRIS Focus features such as live products and dynamic composites require
RAW files.
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Figure 15 Radar Data Delivery Paths

More information

‣ Data Manager (page 77)
‣ Data Manager Does Not Work as Expected (page 100)

5.9.3.1 Setting up Data Manager on IRIS Analysis Server

To configure IRIS Analysis to send RAW files to IRIS Focus, you must set the target location on
the IRIS Focus server as a network output device in IRIS Analysis.

The target location on IRIS Focus server is the following directory, which is owned by the
radardminput user:

/srv/vaisala/radarsw/datamanager/input

1. Log in to the IRIS Analysis server as radarop.

2. In the terminal window, type: setup& 
The IRIS Setup utility opens

3. Select Output.

4. Create a new output device:

a. In Number of output devices, increase the number of output devices by 1.

b. Press ENTER. 
A new configurable output device is added to the end of the Output Device list.
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5. In the configuration pane for the new output device, configure the new output device with
the following settings: 

a. Device type: Network

b. Filename format: Native

c. Target directory: /srv/vaisala/radarsw/datamanager/input
d. User name: radardminput
e. Host name: [IRIS Focus server]
f. Select File > Close.

g. Select File > Save.

h. Select File > Exit.

Chapter 5 – Installation

CONFIDENTIAL 49



6. Restart IRIS:

a. Login as root. 

#su
    #<type password>

b.

systemctl stop iris.service
systemctl start iris.service
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7. In the terminal window, type: iris &
a. Select Menus > Product Output > Device.

b. Select the device you configured in the Setup utility.

c. In the drop down box on the far right of the window, select Headers Only. 

d. In the product list, select any RAW product.

e. Right-click the far right of the product name and select a radar site. 
If needed, deselect any radar sites you do not want to include in the device
configuration.

f. Select Apply.

g. Select File > Save As. 
Define a name for the new Product Output or use the DEFAULT option.

h. Select OK.

i. Select Close.

8. Copy the contents of /root/.ssh/id_rsa.pub to your clipboard.
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9. Log in to the root account with the su command. 
When prompted, type the root password.

10. Launch a one-time SSH connection to the IRIS Focus server. 

ssh [IRIS Focus server IP address]

This saves IRIS Focus server's hostname in the known_hosts file on the IRIS Analysis
server.

5.9.3.2 Setting up Data Manager on IRIS Focus server

RAW files on the IRIS Analysis server are handled by the local root user and RAW files on the
IRIS Focus server by the local radardminput user.

You must add the IRIS Analysis root account’s public SSH key to the IRIS Focus
radardminput accepted keys list.

1. Log in to the IRIS Focus server as root.

2. If it does not exist already, create the following .ssh file: 

# mkdir -m 700 /var/lib/radardminput/.ssh
# chown radardminput:radarsw /var/lib/radardminput/.ssh

3. Add the socket server key to the authorized SSH key store of the radardminput user: 
This enables file transfer from the IRIS Analysis root account to IRIS Focus
radardminput user.

a. Type: 

# cd /var/lib/radardminput/.ssh  
# ls

b. If the authorized_keys file does not yet exist, add this file: 

# vi authorized_keys

Paste the key you copied earlier to your clipboard.

# chown radardminput:radarsw authorized_keys
# chmod 644 authorized_keys

c. If authorized_keys file already exists, type: 

# vi authorized_keys  
# rm socket-server-key

Append the key you copied earlier to the file.
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4. Check that the expected on-demand product is visible in the IRIS Focus user interface. 
A data manager updater service records metadata of the files in a PostgreSQL
database, which is accessed by the IRIS Focus web UI when it generates on-demand radar
products from the data.

5.10 Verifying IRIS Focus Installation

1. Check that the web user interface is running at the default HTTPS port, and the following
default user accounts have been created in IRIS Focus during installation: 

• Username: admin / password: admin123
• Username: user / password: user123

2. Access the IRIS Focus web UI by opening a browser on the IRIS Focus server and
navigating to https://localhost. 
You should see the login screen for IRIS Focus web application.

3. Log in with the default IRIS Focus user account. 
Make sure the application loads, and the map view is displayed.

4. Check that the expected on-demand product is visible in the IRIS Focus user interface. 
A data manager updater service records metadata of the files in a PostgreSQL
database, which is accessed by the IRIS Focus web UI when it generates on-demand radar
products from the data.

5. Verify that Tracking Tool and Cross Section buttons are visible in the application UI. 
This verifies that IRIS Focus features are enabled.

6. Enable the grid lines by selecting Map Features Lat/lon grid. 
Depending on where the map view is centered, you should see slightly distorted grid lines
that are leading away from the equator. This verifies that the map projection is correct.

7. Confirm that data manager is running:

a. Select Weather Products > Add Product.

b. Add a new on-demand PPI or CAPPI product.

c. Make sure you see weather data from the selected time on the screen.
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6. One-server Installation of IRIS Focus
and IRIS Analysis

Follow this procedure when you install IRIS Analysis and IRIS Focus on the same server.

When IRIS Analysis and IRIS Focus are installed on the same server, some steps
differ from the situation where they are installed on separate servers.

1. A prerequisite for installation is that CentOS is installed on the server. 
For one-server installation, install CentOS according to the instructions in IRIS and RDA
Software Installation Guide, chapter Installing CentOS 7 Manually (Interactive). Use the
following disk partitioning:

Table 10 Vaisala-recommended disk partitioning

Partition Size

/home 50 GB

/boot 500 MB

/var 100 GB

/ 100 GB

swap size of RAM + 2 GB

/srv 50% of the remaining disk space

/usr/iris_data 50% of the remaining disk space

Partitions /srv and /usr/iris_data are data partitions. When you are installing IRIS
Analysis and IRIS Focus on the same server, divide the remaining disk space between
these two partitions.
If there is only a little disk space, you can decrease the size of the /home, /var, and /
partitions by 10-20 GB.

2. Install IRIS Analysis according to the instructions in IRIS and RDA Software Installation
Guide.
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3. Install IRIS Focus:

a. If needed, download the installation packages, and verify MD5 hashes. See
Downloading Installation Packages (page 24) .

b. Install IRIS Focus. See Installing IRIS Focus from a USB stick (page 35).

c. Install patch, if needed. See Installing IRIS Focus patch (page 37).

d. Install the IRIS Focus components. See Installing IRIS Focus Components (page 37).

Contrary to the installation of IRIS Focus on its own server, do
not run OS hardening scripts on a server that also has IRIS Analysis
installed.

CAUTION!

4. Configure IRIS Analysis for IRIS Focus. See Configuring IRIS for IRIS Focus in One-server
Installation (page 55)

5. Verify IRIS Focus installation. See Verifying IRIS Focus Installation (page 53).

6. Activate the IRIS Focus license. See Activating License – Online (page 41), Activating
License – Offline (page 44), or Activating the License from a USB Locking Device
(page 40).

6.1 Configuring IRIS for IRIS Focus in One-server
Installation

The data manager service enables IRIS Focus to receive radar scan volume data from IRIS
Analysis.

During installation, IRIS Focus sets up all necessary services, databases, and user accounts for
processing data. IRIS Focus features such as live products and dynamic composites require
RAW files.

6.1.1 Setting up Data Manager on IRIS Analysis Server
To configure IRIS Analysis to send RAW files to IRIS Focus, you must set the target location on
the IRIS Focus server as a network output device in IRIS Analysis.

The target location on IRIS Focus server is the following directory, which is owned by the
radardminput user:

/srv/vaisala/radarsw/datamanager/input

1. Log in to the IRIS Analysis server as radarop.

2. In the terminal window, type: setup& 
The IRIS Setup utility opens

3. Select Output.

Chapter 6 – One-server Installation of IRIS Focus and IRIS Analysis

CONFIDENTIAL 55



4. Create a new output device:

a. In Number of output devices, increase the number of output devices by 1.

b. Press ENTER. 
A new configurable output device is added to the end of the Output Device list.

5. In the configuration pane for the new output device, configure the new output device with
the following settings: 

a. Device type: Network

b. Filename format: Native

c. Target directory: /srv/vaisala/radarsw/datamanager/input
d. User name: radardminput
e. Host name: 127.0.0.1
f. Select File > Close.

g. Select File > Save.

h. Select File > Exit.
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6. Restart IRIS:

a. Login as root. 

#su
    #<type password>

b. Type: 

systemctl stop iris.service
systemctl start iris.service

7. Allow access to the Data Manager input directory:

a. Login as root.

b. Type: 

chmod 777 /srv/vaisala/radarsw/datamanager/input/
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8. In the terminal window, type: iris &
a. Select Menus > Product Output > Device.

b. Select the device you configured in the Setup utility.

c. In the drop down box on the far right of the window, select Headers Only. 

d. In the product list, select any RAW product.

e. Right-click the far right of the product name and select a radar site. 
If needed, deselect any radar sites you do not want to include in the device
configuration.

f. Select Apply.

g. Select File > Save As. 
Define a name for the new Product Output or use the DEFAULT option.

h. Select OK.

i. Select Close.
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7. Configuration

7.1 Adding/Removing Radars
When new radar sites are added or removed as data sources on the IRIS Analysis server, radar
settings on the IRIS Focus server must be re-syncronized. Settings requiring updates include
updating the radar site location in GeoServer and calculating new map projections.

1. Run radar site setup script: 

rsw-basemap-site-setup --socket-server [socket_server_host_name]

2. Stop and restart the IRIS Focus web application service:

a. Type the command: 

systemctl stop vaisala-radarsw-webapp

b. Wait until the process has stopped and the command prompt is ready for the next
command.

c. Type the command: 

systemctl start vaisala-radarsw-webapp

7.2 Starting and stopping the Nowcast server

7.2.1 Enabling the Nowcast Server

You must have a nowcasting license to use nowcasting in IRIS Focus.
See Licensing (page 11).

After a default installation, the nowcast server is running by default.

When troubleshooting nowcasting, check that nowcasting is enabled, and that the nowcast
server is running.

If you change the configuration, you must restart the nowcast server.

1. Log in as root.

2. Go to /etc/vaisala/radarsw/configuration/vsoweb-override.ini.
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3. In the [NOWCAST] section of the vsoweb-override.ini file, check that the nowcast
server is enabled: 

nowcast.mvf.run: true

4. Check the nowcast server URL: 

nowcast.http.server.url = http://localhost:34480/api/v1/mvf/

If you have not changed vsoweb-override.ini, you do not need to
restart the vaisala-radarsw-webapp server.
The nowcast server is running by default. If you have not changed
nowcast.ini, you do not need to restart the nowcast server.

5. Restart the vaisala-radarsw-webapp service by typing: 

systemctl restart vaisala-radarsw-webapp

6. Start the nowcast server by typing: 

systemctl start vaisala-radarsw-nowcast-server

a. To verify that the server starts, type: 

systemctl status vaisala-radarsw-nowcast-server.service

b. Check for the status: 

Active: active (running)

7.2.2 Starting the Nowcast Server

1. Log in as root.
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2. Start the nowcast server by typing: 

systemctl start vaisala-radarsw-nowcast-server

a. To verify that the server starts, type: 

systemctl status vaisala-radarsw-nowcast-server.service

b. Check for the status: 

Active: active (running)

7.2.3 Stopping the Nowcast Server

1. Log in as root.

2. Stop the nowcast server by typing: 

systemctl stop vaisala-radarsw-nowcast-server

7.2.4 Restarting the Nowcast Server

1. Log in as root.

2. Restart the nowcast server by typing: 

systemctl restart vaisala-radarsw-nowcast-server

7.3 Setting up housekeeping for events and alerts
database

You can set IRIS Focus to clean the alerts database when it is getting full, and to give an alert
when the database load is approaching the database size limit. By default, this feature is
enabled. The database size limit is set automatically depending on the partition/disk size
reported by the operating system during the installation, but you can change this limit. The
default is 10% of the hard disk partition. By default, the database is installed in the /srv
partition.

You can select the limit that triggers the alert. The default is 90% of the size limit. You can also
set the clean-up target. The clean-up target tells how many of the latest alerts will be kept in
the database.
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If you want to save the old alerts, do one of the following when you get the alert about the
approaching clean-up:

• Take a manual backup of the database.
• Add disk space to the partition. Restart the webapp after this.
• Increase the configured database size limit (%). Restart the webapp after this.

1. Log in as root.

2. Go to the vsoweb-override.ini file in the /etc/vaisala/radarsw/
configuration directory.

3. Set the maximum percentage of disk partition to use (database size limit) by setting the
value: 

events.alerts.housekeeping.trigger.partition.percentage

4. Set the limit that triggers the alert (percentage of the maximum number of alerts) by
setting the value: 

events.alerts.housekeeping.alert.percent.full

5. Set the clean-up target by setting the value: 

events.alerts.housekeeping.target.limit

6. If you want to disable the database housekeeping, set the following key to false: 

events.alerts.housekeeping.do.housekeeping = false

7. If you want to disable the alerts for housekeeping, set the following key to false: 

events.alerts.housekeeping.alert.before = false

8. Restart the web application.

7.4 Configuring visualization of hybrid tasks
When you use hybrid tasks, you can select whether partially finished hybrid scans are
displayed on IRIS Focus or not. By default, partial hybrid scans are displayed.

If you want that only completed volume scans are displayed, follow these steps:

1. Log in as root.

2. Go to the vsoweb-override.ini file in the /etc/vaisala/radarsw/
configuration directory.
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3. Set the HYBRID_PRODUCT_TIMES parameter to false: 

use.partial.hybrid.times = false

4. Restart the web application.

If you want to reset IRIS Focus to display partial hybrid scans, reset the
HYBRID_PRODUCT_TIMES parameter to true, and restart the web application.

7.5 Enabling Lightning Layer
To take the lightning layer into use, the IRIS Focus server must be online and your organization
must have an active subscription to GLD360 data. For information on subscribing to GLD360
data, contact Vaisala Lightning Data Services.

1. Log on to the IRIS Focus server as root.

2. Type the command: 
rsw-lightning-configure -r [admin username] -p [admin password]
-s https://storm.vaisala.com/geolegends/ltg_combined_25.sld

3. Edit the configuration file vsoweb-override.ini:nano /etc/vaisala/
radarsw/configuration/vsoweb-override.ini to contain a reference to the
Vaisala GLD360 URL you received: 

lightning.wms.url = [URL from GLD360]

4. Stop and restart the IRIS Focus web application service:

a. Type the command: 

systemctl stop vaisala-radarsw-webapp

b. Wait until the process has stopped and the command prompt is ready for the next
command.

c. Type the command: 

systemctl start vaisala-radarsw-webapp

More information

‣ Lightning Layer (page 22)
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7.6 Scheduling Image Exports from IRIS Focus
If you want to share interesting weather events on, for example, your website, use a REST
POST method to schedule image exports from IRIS Focus saved views.

Depending on setup of the target website, the image export can be
a bit slow. Take this into account when planning your export volumes and
schedules.

CAUTION!

1. In the IRIS Focus Map view, set-up the view you want to save. 
For example, you can save the settings for:

• Weather Products
• Map tools such as the cross-section and tracking tools
• Zoom level

2. Select Saved Views > Save.

3. Name the view and select Save. 
The new view is added to the Saved Views list for your future use.

4. Configure your web server to access the IRIS Focus image export service: 

@Request: POST <your IRIS Focus URL>/imageExport/getImage
@Produces: "image/png"

5. Configure the following parameters: 

Parameter Description

username A valid IRIS Focus username.

For security reasons, Vaisala recommends that you
configure a specific user for exporting images.

password IRIS Focus password for the user.

time Time, in ISO-8601 format: 2019-01-18T17:55:23.000Z

widthPx Width of the exported image, in pixels.

heightPx Height of the exported image, in pixels.

savedViewName The name of the saved view you created in step 3.

savedViewUser Optional value. Used if you configure a specific user for exporting
images (recommended).
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6. Instead of step 4 and step 5, you can run the export from the command line by creating a
script and setting-up a cron job. For example:

a. Create a Python script for the image export such as the following: 

#!/usr/bin/python
# -*- coding: utf-8 -*-

from requests_futures.sessions import FuturesSession
import datetime

APP_URL = "your_url_here"
IMAGE_EXPORT_LOC = "/imageExport/getImage"
FILE_PATH = "/path/to/image.png"
USERNAME = "username_here"
PASSWORD = "password_here"
TIME = datetime.datetime.utcnow().isoformat()
WIDTH = "1000"
HEIGHT = "700"
VIEW = "view_name_here"

def main():
    session = FuturesSession()

    req_params = {"username": USERNAME, "password": PASSWORD, "time": 
TIME, "savedViewName": VIEW, "widthPx": WIDTH, "heightPx": HEIGHT}

    future_one = session.post(APP_URL + IMAGE_EXPORT_LOC, 
params=req_params)
    
    # wait for the request to complete, if it hasn't already
    res = future_one.result()
    print('{0}  response status: {1}'.format(TIME, res.status_code))

    if res.status_code == 200:
      with open(FILE_PATH, 'wb') as f:
          f.write(res.content)

if __name__ == '__main__':
    main()

Although the example image-export.py script saves only one snapshot, you can
edit it to loop a set number of times and get multiple snapshots at a time.

b. Type crontab -e in the terminal and add, for example, the following line to the
crontab file (add your own paths and arguments). 

*/15 * * * * /usr/bin/python
        /path/to/script/image-export.py >> /path/to/log/export.log 2>&1

This executes the image-export.py script every 15 minutes and saves a single
snapshot as a PNG file to the server.
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7.7 Importing Historical Data to IRIS Focus
You can import historical data into IRIS Focus to use the same IRIS Focus visualization and
analytical tools available for current data.

To import the data, use one of the following import methods:

• Transfer RAW product data from IRIS Analysis on the IRIS back-end to the IRIS Focus
machine.
See IRIS Focus Architecture (page 17).

• Import a data archive by sending a collection of IRIS RAW products over the network using
an SCP command. See the following steps.

1. Set up public key authentication for the machine you are copying from: 
On the _my.iris.focus.server machine, add the key from the source machine to
the radardminput user's ~/.ssh/authorized_keys file .

2. Use SCP to copy all the files from /storage/raw/archive/ to the IRIS Focus Server.
For example: 

find "/storage/raw/archive" -type f -exec scp {} 
radardminput@my.iris.focus.server:/srv/vaisala/radarsw/datamanager/input;

The Data Manager input service expects only IRIS RAW files. Make sure you do
not copy a directory or zip file.

3. To monitor the data import, or troubleshoot if the data does not appear on the IRIS Focus
web interface, check the Data Manager input service log: 

journalctl -u vaisala-radarsw-data-manager-input-service -f

The Data Manager input service imports the files to Data Manager for use in IRIS Focus.
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8. System Administration

8.1 User roles
Access to IRIS Focus features depends on the roles enabled for each user account. Each user
account belongs to one or more organizations.

For example, the administration features are available to user accounts with the
administrator role.

Table 11 IRIS Focus User Roles

Role Description

administrator Can access administration features.

Users with an administrator role must belong to the root organization.

focus Can access the full IRIS Focus feature set.

poweruser Can access the full IRIS Focus feature set.

Can create organization-level event criteria and places of interest that are
visible to all users in an organization.

Can set up and manage pre-defined composites.

Can configure MVFs to be used in nowcasting.

Can select an organization-level map projection.

user Can access the limited set of features available with IRIS Focus Light.

kiosk Can only access the non-interactive, full-screen Kiosk mode.

To enable all IRIS Focus features for an account, set both user and focus roles
for that account.

Seat Allocation and Restrictions

Each logged-in user account with a focus or poweruser role reserves one IRIS Focus seat
from the license pool. When the user logs out, the seat is released.

A user account that has user or administrator role, or another role without a focus role,
enters IRIS Focus Light, which has a map view with limited features and does not provide
access to features such as cross-section or on-demand radar products.

If a user with a focus role logs in and there are no IRIS Focus seats available, the user enters
IRIS Focus Light. When a seat is available, the user is provided with an opportunity to switch to
IRIS Focus.
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To avoid reserving an IRIS Focus license when performing administration tasks,
the default administrator account does not have the focus role.

More information

‣ Licensing (page 11)

8.1.1 Managing User Accounts

1. Log in with an administrator account.

2. Select Admin in the upper right corner.

3. Select Users to add, edit, or delete users.

8.1.2 Creating User Accounts After First Install
After a fresh installation, create the user accounts.

1. Log in to IRIS Focus as admin.

2. Select Admin > Organizations.

3. Choose which organization you want to create your users in:
• Use the default root organization.
• If you require more control over license seat allocation, create a new organization in

the Organizations tab.

Users with an administrator role must belong to the root organization.
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4. In the Application Subscriptions tab, subscribe the organization to a license pool.

a. Select the radarsw organization.

b. Enter the validity period.

c. Enter the maximum allocated users (licenses). 
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5. To add users to the organization, select Admin > Users > Add New User. 

a. Add user details.

b. Select an organization for user. 
If a user account belongs to multiple organizations, the user roles are applied
according to the organization that has the highest Rank.
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6. Assign roles to the user. 

To avoid reserving an IRIS Focus license when performing administration
tasks, the default administrator account does not have the focus role.

a. In the organization list pane, make sure the organization is highlighted.

b. In the Roles pane, select the role. 
To assign multiple roles to a user account, press SHIFT+CTRL and select roles from
the list.

c. To enable IRIS Focus features for a user account, select both the user and focus
roles.

d. To enable advanced IRIS Focus features such as creating event criteria and
organization-level places of interest for an account, select the poweruser role.

8.1.3 Removing User Accounts

1. Log in as admin.

2. Select Admin > User > Users.

3. Select a user and then Delete. 
The user is no longer listed as a user in IRIS Focus. However, the user name of the deleted
account remains in the system database. This keeps log files intact, as references to
deleted users remain in the audit logs.
IRIS Focus does not allow you to create a new user with the same username as an existing
one. This applies even when the account has been removed earlier, because the account
name remains in the database.

8.1.4 Unlocking administrator account
If an administrator account is accidentally locked, unlock it as follows:

1. Login as root.

2. Run the following command: 

rsw-db-tool reset-admin-password

8.2 Managing Organizations
Each user account belongs to one or more organizations. You can use organizations to
manage:

• Subscriptions to selected software to a selected number of users.
• License availability for subgroups with separate license pools.
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• Events and places of interest created by a poweruser.

Users with an administrator role must belong to the root organization.

8.3 Map Management
The standard installation of IRIS Focus includes a complete world map that is suitable for most
scenarios.

The map consists of separate layers that are further separated into base layers and non-base
layers. One base layer and one non-base layer are always rendered on the screen. Typically,
base maps contain the underlying terrain and the non-base layers contain additional details
that can be displayed on top of the base map.

Map data is served to the IRIS Focus web interface by GeoServer map server using Web Map
Service (WMS) protocol. To improve performance, instead of calling for new map data each
time the map view changes, the maps are cached in pre-rendered PNG tiles using
GeoWebCache.

Administrators can add custom map layers or edit existing layers.

IRIS Focus users can select which map layers they see in the Map view, and edit the view by
selecting Map Features.

8.3.1 Adding and Editing Map Layers

1. Log in as admin.

2. Select Admin > Map > Map Layers. 
The Map Layers view lists the available map data layers. Each layer has the following
properties:

• Base layer - Enable to set this layer as a base layer
• Title - Layer name
• Type - WMS layers
• URL - Address for the WMS server
• Layer - Title of the layer on the server
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3. To add a new layer, select Add New Layer.

a. Type the layer information, including Title, URL, and Layer.

b. Define map layer properties such as: 
• Transparent - Enable to use PNG or GIF alpha channel for transparency
• MIME type - Select image type

When you are adding a WMS layer from an external source, note the following:
• Get the URL from the layer provider.
• You can set any values for Realtime offset and Refresh rate, but if the exact value is

not available from the layer provider, the system will give you a time closest what you
defined.

• In order for the system to query for the cursor tool data, check the Usable in map 
cursor checkbox.

• Layer style defines the availability of the color legend in the map view. IRIS Focus
supports both .sld files and WMS methods of providing the legend.

• If you do not want the layer to be visible to users, after adding a layer, go to the Map 
View Contexts screen, and uncheck the Visibility checkbox.

• The user can see the added external WMS layer in the Add Product drop-down list of
the Weather Products pane.

4. To edit a layer, select Edit for that layer and make your changes. 
The Map Layer Information window for that layer opens.

5. Select Save.

More information

‣ Map Layer Configuration Options (page 108)

8.3.2 Map View Context
The Map View Contexts view lists all defined maps.

Only the default TheMap context is available. Perform all map layer customization in the
default TheMap context. Do not create new map contexts for custom map layers.

To edit TheMap, select Edit.

• To make a map layer available for users in the map view, select the Selected checkbox in
the Edit Map View Contexts.

• To set the order in which multiple map layers are rendered on screen, change the Z level
of map layers.
The lowest number is rendered first, and higher numbers rendered on top of that.
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Figure 16 Editing the Map Context

8.3.3 Adding external map layers
You can import an external map layer, such as a shapefile, into Geoserver for IRIS Focus to
display on the map.

For information on adding WMS layers from external sources, see Adding and Editing Map
Layers (page 72).

1. Make sure you have a shapefile (.shp) available. 
For an example resource with shapefiles available for download, see the WGS84
projection examples at:
https://osmdata.openstreetmap.de/data/coastlines.html

2. Use an scp client or similar application to copy the shapefile to a directory on the IRIS
Focus server such as /srv/.

3. Login to the server as radarop.

4. Open the file: /etc/vaisala/radarsw/configuration/gis-override.ini
5. Copy the geoserver.admin.password . 

This password is autogenerated during installation.
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6. Using a browser, login to IRIS Focus Geoserver at: 
http://<IRIS_Focus_server_name>:34180/geoserver/web/
Login using the username admin and the password you copied earlier.

Depending on your own network configuration you may need to do this at
the server, over a remote console, or by using your local browser.

7. Add a new Store:

a. Select Stores > Add New Store.

b. Choose the data source: Shapefile - ESRI(tm) Shapefiles (*.shp)

c. Select the following (the following list shows example values). 
• Workspace: Vaisala
• Data Source Name: coastlines
• Description: leave blank
• Shapefile location: browse to the shapefile

For example: \files\lines.shp
d. Leave the other fields as default.

e. Select Save.

8. Publish the layer:

a. Check that the New Layer menu opens.

b. If the New Layer menu does not open automatically, select Layers > Add New Layer.

c. In the Add layer from list, find the new layer.

d. Select Publish.

The Edit Layer menu shows the new layer name. For example, vaisala:coastlines.

9. In the Edit Layer menu:

a. Leave all inputs as they are except: 
• Name: coastlines
• Title: coastlines
• Coordinate Reference Systems > Declared SRS
• Select Find and search for 4326 (WSG 84).

b. To fill the bounding boxes, select Compute from data and Compute from native 
bounds.

c. Select Save.

10. Select Layer Groups.

a. Select an existing layer group (for example, vai_full_en) and then select Add 
Layer.

b. Find the new layer and add it. 
The layer is now listed in the Layers table.

c. Select Save.

Chapter 8 – System Administration

CONFIDENTIAL 75

http://%3Cserver%3E:34180/geoserver/web/


11. Login to IRIS Focus as a user.

12. To confirm that the new layer is visible, select Map Features > Map Detail > Full Detail.

8.4 systemd
systemd and its logging daemon journald are CentOS 7 components that manage system
services.

systemd manages more functionality than its predecessors, and some of the mechanisms,
such as accessing certain log files, have changed.

In CentOS 7, system logs are not directly accessible as files. Instead, they are read with the
journalctl command.

8.5 Monit
Monit is a watchdog tool for monitoring Unix systems and processes. IRIS Focus uses Monit to
automatically restart the application or a related process or service if it becomes unstable.

If you do maintenance work that requires you to take the application down, you must first stop
Monit before proceeding further, and restart it after maintenance.

In the command line, the Monit service is called monit.

8.6 HAProxy
HAProxy is a proxying tool that IRIS Focus uses for traffic forwarding within the system and
HTTPS encryption for outgoing traffic.

In the command line, the HAProxy service is called haproxy.

More information

‣ Encryption (page 98)

8.7 IRIS Focus Web Application
This is the main web UI of the IRIS Focus system.

In the command line, the IRIS Focus web application service is called vaisala-radarsw-
webapp.

8.8 GeoServer
GeoServer is used for caching and generating the base map layers.
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In the command line, the GeoServer service is called vaisala-radarsw-geoserver.

8.9 Data Manager
Data manager is the HTTP/REST interface that provides raw data for on-demand (Live) radar
products.

Table 12 Data Manager Services

Service Description

vaisala-radarsw-data-manager Listener.

vaisala-radarsw-data-manager-
input-service

HTTP server for live radar products that are
queried from the IRIS Focus web application.

More information

‣ Data Manager Disk Space Requirements (page 15)
‣ Setting up Data Manager (page 47)
‣ Setting-up Dataflow Alerts (page 77)
‣ Viewing Dataflow Alerts (page 79)
‣ On-demand Radar Products (page 20)

8.9.1 Setting-up Dataflow Alerts
Enable and set-up data flow alerts to monitor the flow of radar data to IRIS Focus through
Data Manager.

1. Run the radar system for some time to allow the Data Manager database to populate.

2. Log in to IRIS Focus as admin.
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3. Select Admin > Data Manager > Data Flow Alerts. 
The Data Flow Alerts page opens.

Task
Radar task associated with the dataflow.

 Enabled Alerts
If selected, IRIS Focus generates an alert if the dataflow for that task is interrupted.

Task Interval
Shows the interval between task run times. (minutes).
Data Manager re-calculates the frequency automatically each time you open the
Data Flow Alerts page. To refresh the times manually, select Refresh.
The timestamp shows the last detected date for received data.

Alert Trigger Time
The time (minutes) after which IRIS Focus generates an alert if the dataflow is
interrupted.

4. To receive alerts about interruptions to the flow of task data:

a. In the Enabled Alerts column, select the check box.

b. In the Alert Trigger Time column, set a time that is higher than the expected data
flow interval.

c. To manage all enabled alerts in the same way, use the input filed at the top of the
Alert Trigger Time column and then select Apply all: 

• To set the same trigger time for all alerts, type a number in the input field.
• To increase the alert trigger time for all alerts, type, for example, +5 in the input

field. To decrease the time, type, for example, -5.
• To set a trigger time that is the same as detected interval between task run times

for all alerts, leave the input field blank.

5. Select Save.
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More information

‣ Data Manager (page 77)

8.9.2 Viewing Dataflow Alerts
If there is a break in the flow of radar product data, IRIS Focus sends a dataflow alert.

1. On the right side of the main menu, select Alerts > Technical.

2. In the Alerts pane, acknowledge the alert. 
The acknowledgement records who has seen the alert and when.
Acknowledging alerts has no effect on the alert status.

More information

‣ Data Manager (page 77)

8.9.3 Setting Up Data Manager Housekeeping Service
When Data Manager exceeds its allocated disk space, the background housekeeping service
begins to delete volume scans, starting from the oldest.

Data Manager disk space is allocated during installation, but can be modified later on.

1. Log in as root.

2. Go to /etc/vaisala/radarsw/data-manager/data-manager-
override.properties.

3. The disk space allocation for Data Manager is configured during installation. If you wish to
change the allocation later on, use the datamanager.volumeDir.maxSizeMB
parameter. For example: 

datamanager.volumeDir.maxSizeMB = 1000

4. Define how often housekeeping checks for disk overusage (milliseconds). 

datamanager.housekeeping.fixedRate.ms = 60000

Vaisala recommends running this check once a day.
While this checks runs, other operations on Data Manager slow down.

5. Define the delay for when housekeeping first runs after Data Manager has been started or
restarted (milliseconds). 

datamanager.housekeeping.fixedDelay.ms = 60000
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6. Restart Data Manager: 

systemctl restart vaisala-radarsw-data-manager

8.9.4 Running Data Manager Clear Data Script
Use the rsw-data-manager-clear-data script if the Data Manager data storage
becomes corrupt or if there is a need to remove all data from Data Manager.

Running the script deletes all radar data from IRIS Focus, including
Nowcasting configurations, pre-defined composite configurations, and RAW
radar data.

CAUTION!

1. Run the script: 

DM_RESET=yes rsw-data-manager-clear-data

If there is a lot of RAW radar data in Data Manager, it may take some time to run the
script.

Do not interrupt the script execution.CAUTION!

When the script is complete, Data Manager restarts automatically and you can continue using
IRIS Focus.

8.10 Stopping, Starting, and Restarting Services
You should only need to start or stop a service during certain troubleshooting cases. These
cases are described step-by-step in the Troubleshooting section. In normal circumstances the
services are always running.

In CentOS 7, services are stopped, started, and restarted with the systemctl stop /
start / restart [servicename] command.

To use the systemctl command, you must be a logged in as the root user.

The following example shows how to stop, start and restart the IRIS Focus web application
service. Note that the Monit service starts along with the web application.

Stopping the service

• systemctl stop monit
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• systemctl stop vaisala-radarsw-webapp

Starting the service

• systemctl start vaisala-radarsw-webapp
• systemctl start monit

Restarting the service

• systemctl restart vaisala-radarsw-webapp

8.11 Logging
IRIS Focus log files are stored in directory /var/log/vaisala/radarsw/webapp, which
contains:

• Application error log: webapp.log
• Information about application performance: webapp-metrics.log

Older logs are rolled over to separate files and zipped automatically in .gz files. No log files
are deleted automatically.

The logging configuration file is in /etc/vaisala/radarsw/configuration/
logback.xml.

8.11.1 Reading System Service Logs
When diagnosing issues with the IRIS Focus server, you may need to access the log files from
system services using the CentOS 7 Journal tool:

journalctl -u [service-name] -l -f --no-pager

Some useful options for journalctl are:

• -u for showing log entries for a given service
• -n for showing only a given number of recent log lines
• -f for following new log entries being logged
• --no-pager for not using a pager program such as less for the output
• -l to print out full log lines and not ellipsize (shorten) them.

For more information, type man journalctl in CentOS 7, or Using the Journal at RHEL
System Administrators Guide (https://access.redhat.com/documentation/en-US/
Red_Hat_Enterprise_Linux/7/html/System_Administrators_Guide/s1-
Using_the_Journal.html)

8.11.2 Reading Nowcast Server Logs
The nowcast server logs are useful when diagnosing issues with the nowcast server.
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1. Check the status of the nowcast server by typing: 

service vaisala-radarsw-nowcast-server status

2. Check the logs by typing: 

journalctl –f

8.12 Installing a CA Certificate
The web application comes with a temporary, self-signed SSL certificate that secures the
connection between the IRIS Focus server and the user's web browser.

Consider acquiring and using a trusted certificate from a certificate authority (CA), especially if
you plan to offer access to IRIS Focus outside your organization.

1. Acquire a certificate that has been signed by a trusted authority. 
This is usually done by an IT department or an external organization, who purchase the
certificate from an external certificate authority (CA).

2. Back-up your current configuration by running: 

run /usr/vaisala/radarsw/backup/bin/do-backups

This backs up all the configuration files as a .tar file to /srv/vaisala/radarsw/
backup/configuration.

3. Go to the default certificate folder: 
/etc/vaisala/radarsw/webapp-proxy/certificates/cert.pem

a. Back up the file locally by running: 

cp /etc/vaisala/radarsw/webapp-proxy/certificates/cert.pem /etc/vaisala/
radarsw/webapp-proxy/certificates/cert.pem.bkp

b. Replace the certificate in the file with the new, signed certificate.

More information

‣ Web Application (page 23)
‣ Certificates (page 98)
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8.13 Backing-up System Configuration
IRIS Focus is backed up automatically using a daily configuration and database backup job
that are run at 02:30 AM server time. On factory settings, the server uses UTC as the time
zone.

The backup script stores the server configuration and application settings database.

Automatic Back-up

Backup is done by the cron job /etc/cron.d/vaisala-radarsw-backup-cron that
launches the /usr/vaisala/radarsw/backup/bin/do-backups script.

The created backup files are zipped and stored in the following directories:

• /srv/vaisala/radarsw/backup/configuration
• /srv/vaisala/radarsw/backup/database

Backups are kept for 180 days, after which they are deleted.

Each backup file includes a timestamp in the format:

radarsw-configuration-2019-09-05T06-48-26.tar.gz

8.13.1 Making a Manual Back-up

1. Log in as root.

2. Run: /usr/vaisala/radarsw/backup/bin/do-backups
3. Check that new files are created in the following directories: 

/srv/vaisala/radarsw/backup/configuration/radarsw-configuration-
<timestamp>.tar.gz

/srv/vaisala/radarsw/backup/database/database-wx-<timestamp>.gz

/srv/vaisala/radarsw/backup/database/database-vsp-<timestamp>.gz

Each backup file includes a timestamp in the format:

radarsw-configuration-2019-09-05T06-48-26.tar.gz

8.14 Restoring from Backup

1. Log in as root.
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2. Stop the Monit service: 

systemctl stop monit.service

3. Stop the IRIS Focus web application: 

systemctl stop vaisala-radarsw-webapp.service

4. (Optional) Run the backup script: 
/usr/vaisala/radarsw/backup/bin/do-backups

a. Copy the current configuration files to a remote host.

b. Copy the resulting configuration file to your own machine: /srv/vaisala/
radarsw/backup/configuration/radarsw-
configuration-2019-10-12T09-42-18.tar.gz

5. Copy the current database passwords from /etc/vaisala/radarsw/
configuration/vsoweb-override.ini. 
Save them in a text file for step 12.

[DATASOURCE]
datasource.password = xsGzN3ZK6kMqvaH6dzJQqAg1KwTMLnJL

[VSP_DATASOURCE]
datasource.password = AgbBWtR0XqDh64DgklkK6XqLXsnQP08U

6. Copy the current Data Manager password from /etc/vaisala/radarsw/data-
manager/data-manager-override.properties. 

/etc/vaisala/radarsw/data-manager/data-manager-override.properties
spring.datasource.password = bFKNUQ5fvFMfmsU3vWP3CEYJHVTuOJ2Z

Save it in a text file for step 12.

7. Drop the current database with the rsw-db-tool utility: 

rsw-db-tool drop-db

8. Recreate an empty database: 

rsw-db-tool create-db

9. Switch to the database user account postgres: 

su – postgres
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10. Copy your backup files back to the Focus server and restore the database contents by
reading the file contents into thestandard output stream and inserting them in the IRIS
Focus databases: 

gzip --decompress --to-stdout /radarsw-database-vsp-2019-10-12T07-54-50.gz 
| psql vsp_v1
gzip --decompress --to-stdout /radarsw-database-wx-2019-10-12T07-54-50.gz 
| psql wxdb2

11. Exit the postgres user shell: 

exit

12. Using the passwords you stored in step 5 and step 6, replace the database passwords in
these files: 

/etc/vaisala/radarsw/configuration/vsoweb-override.ini
/etc/vaisala/radarsw/data-manager/data-manager-override.properties

13. Start the IRIS Focus web application: 

systemctl start vaisala-radarsw-webapp.service

14. Start the Monit service: 

systemctl start monit.service

8.15 Server Management Software
If you are running server management software on your IRIS Focus server, make sure the
management software's settings do not interfere with your intended network settings.

For example, in Dell PowerEdge servers, the integrated Dell Remote Access Controller (iDrac)
sets a default static IP address for the server when it is first deployed.

On Vaisala preconfigured IRIS Focus systems, iDrac is disabled by default.

8.16 Licensing on Server Restart
Active sessions and their licenses are not stored when the IRIS Focus server is shut down.

When the server restarts, the licensing seats are allocated from scratch to users who log in.
The total number of seats in the license pool is unaffected.
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More information

‣ Licensing (page 11)

8.17 Licensing on Systems with Mirrored HDDs
(RAID 1 or RAID 5)

IRIS Focus licenses are mapped, among other parameters, to hard disk IDs. Removing or
replacing one hard disk in a RAID array can cause unexpected behavior. When doing so, renew
your license. Contact your Vaisala customer representatives for further instructions.

More information

‣ Licensing (page 11)

8.18 Reactivating the License After Server
Upgrade

The product key in the IRIS Focus license is server-specific. If you upgrade your server, you
must request a new service key and activate the new license.

1. Contact Vaisala and request a new server key.

2. Set-up your new server by performing the steps in the following sections: 

a. Installing CentOS (page 26).

b. Installing IRIS Focus Components (page 37).

c. Setting up Data Manager (page 47).

d. Verifying IRIS Focus Installation (page 53).

3. Reactivate the license. 
Depending upon whether or not your server is connected to the internet, see:

• Activating License – Online (page 41)
• Activating License – Offline (page 44)
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9. Upgrade

9.1 Upgrading IRIS Focus 4.0 or later to IRIS Focus
5.x.x

The following instructions assume that you are upgrading from IRIS Focus 4.0 or a later
version to IRIS Focus 5.x.x.

You can upgrade to IRIS Focus 5.x.x from IRIS Focus 4.0 or a later version. If you
have an earlier version of IRIS Focus, you must upgrade through each previous
version to IRIS Focus 4.0 before you can upgrade to IRIS Focus 5.x.x.

When you upgrade from IRIS Focus 4.0 to 5.x.x, the data in Data
Manager is deleted. The MVF and composite definitions are also no longer
available after the upgrade. Vaisala recommends you back-up your system
configuration before upgrading.
For information on adding the historical data to your system after the upgrade,
see IRIS Focus Administrator Guide.

CAUTION!

When you upgrade from IRIS Focus 5.x.x from version that is later than 4.0, the
data in Data Manager is not deleted.

After upgrading from IRIS Focus 4.0 to 5.x.x, you need to re-create your areas of interest.

9.1.1 License
This upgrade requires a new license. The upgrade instructions include a step for identifying the
Lock ID that you need for getting the new license.

If you have a contract agreement with Vaisala, you should receive your upgrade license via
email. If you have not received the license, please contact Vaisala technical support at
helpdesk@vaisala.com. In other cases, please contact your Vaisala Sales representative to get
a new license.

It is possible to upgrade your system without a valid license with
the command ./rsw-upgrade --online --skip-license, but it is not
recommended. Upgrading without a valid license will cause your system to stop
or run in a degraded state until you receive and install a valid license file.

CAUTION!

You can check license file information by running the following script:
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rsw-license-info

A copy of the script is included in the installation media, so that you are able run it prior to
install. Another copy will be installed on the system, so that you can check the license after the
installation.

9.1.2 Running the upgrade

To view installation command line options, run: ./rsw-upgrade –h

In the following instructions, x.x means the Iris Focus version and patch number.

1. Log in as root.

2. Backup the system configuration. 
See Making a Manual Back-up (page 83).

3. Insert the upgrade USB stick.

4. Copy the file Vaisala_IRIS_installer-5.x.x.tar from the USB stick to the
server's hard disk drive, for example, to the /root directory.

5. Change to the /root directory and extract the .tar file: 

#tar -xvf Vaisala_IRIS_installer-5.x.x.tar

, where x.x is the Iris Focus version and patch number.

6. Change to the directory created in the earlier step: 

Vaisala-IRIS-Focus-v5.x.x-RC1--69
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7. If you already have a new license, proceed to step step 10. If you do not have a new license
file yet, type the following command to identify your system's Lock ID: 

./rsw-license-info 

The output shows your system's new Lock ID, as well as information indicating that the
current license file is invalid. Example:

Lock ID: *1KTW99ERX5MBRL2
Error: Locking criteria should be 0x18 or 0x80. It is: 0x4.
IniFile: license/license.ini
LicFile: /etc/vaisala/radarsw/configuration/license.txt
Version: n/a
Valid: false
Active: false
Starts: n/a
Ends: n/a

8. Contact Vaisala Technical support or your Vaisala Representative to get the license file.
You will need to provide the Lock ID.

9. When you have received the new license file and saved it on your server, verify that it is
valid with the command: 

./rsw-license-info --license /mnt/usb/license-5.x.x.txt

, where you replace /mnt/usb/license-5.x.x.txt with the location of your license
file.
If the license file is valid, both the Valid and Active fields will report true. Example:

Lock ID: *1KTW99ERX5MBRL2
IniFile: license/license.ini
LicFile: /mnt/usb/license-5.2.txt
Version: 5.2
Valid: true
Active: true
Starts: 2010-01-01T00:00:00Z
Ends: 2021-12-31T00:00:00Z
Feature: IRIS_Focus_Light (seats: 10)
Feature: IRIS_Focus_Version (seats: 10)
Feature: IRIS_Nowcast (seats: 10)
Feature: IRIS_Focus (seats: 10)
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10. Run the upgrade script:
• Online upgrade:

./rsw-upgrade --online --license
          /mnt/usb/license-5.x.x.txt

• Offline upgrade:

./rsw-upgrade --offline --license
          /mnt/usb/license-5.x.x.txt

11. Verify the upgrade by running: rpm –qa | grep vaisala 
Check that the rpm name is the correct version and patch number.

9.2 Upgrading IRIS Focus 4.0 or 5.0 to IRIS Focus
5.1

The following instructions assume that you are upgrading from IRIS Focus 4.0 or a later
version to IRIS Focus 5.1.

You can upgrade to IRIS Focus 5.1. from IRIS Focus 4.0 or a later version. If you
have an earlier version of IRIS Focus, you must upgrade through each previous
version to IRIS Focus 4.0 before you can upgrade to IRIS Focus 5.1.

This procedure deletes the contents of the data manager database.
Make sure you back-up the database before you begin. The database will
repopulate when you begin to run data after the upgrade.

CAUTION!

1. Log in as root.

2. Backup the system configuration. 
See Making a Manual Back-up (page 83).

3. Insert the upgrade USB stick.

4. Copy the file Vaisala_IRIS_installer-5.1.tar from the USB stick to the server's
hard disk drive, for example to the /root directory.

5. Change to the /root directory and extract the .tar file: 

#tar -xvf Vaisala_IRIS_installer-5.1.tar
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6. Change to the directory created in the earlier step: 

Vaisala-IRIS-Focus-v5.1-RC1--69

7. Run the upgrade script. 
Online upgrade:

./rsw-upgrade --online

Offline upgrade:

./rsw-upgrade --offline

To view installation command line options, run: ./rsw-upgrade –h

8. Verify the upgrade by running: rpm –qa | grep vaisala 
Check that the rpm name is version 5.1.

9.3 Preparing to Upgrade to IRIS Focus 3.0 to IRIS
Focus 4.0

1. Verify the size of the /srv and /var partitions: 

df -h | grep /srv
df -h | grep /var

Take note of the displayed disk sizes.
For example /srv = 900G, /var = 30G
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2. Back up /srv:

a. Log in as root.

b. Change directory: 

cd /home

c. Make sure that there is enough space on /home for the contents of /srv.

d. If needed, clear space on a partition or mount a separate hard disk to make the
backup.

e. Compress the /srv directory into a tar file. c

tar -zcvf srv.tar /srv

3. Stop services: 

systemctl stop monit; systemctl stop vaisala-radarsw-*

The following services are stopped:

{webapp, warn-reader, scan-http-service, scan-updater-service, nowcast-
server, geoserver}

4. Unmount the filesystem on the /srv partition: 

umount <srv-mount-point> 

Run the command lvdisplay | grep /srv to show the mountpoint for /srv. For
example /dev/centos/srv .

5. Remove the /srv logical volume: 

lvremove <srv-mount-point>

6. Create a new /srv logical volume: 

lvcreate -L 830G -n srv <volume group name> 

Replace 830 G with an amount 75 GB less than the original /srv value.
The <volume group name> is, for example centos in /dev/centos/srv <srv-
mount-point>.

a. Select y to wipe the xfs signature.

Version 5.3 Administrator Guide M211850EN-H

92 CONFIDENTIAL



7. Create xfs filesystem on the newly created volume: 

mkfs.xfs <srv-mount-point>

8. Mount the filesystem: 

mount <srv-mount-point> /srv

9. Put the files back to /srv: 

tar -xf srv.tar -C /

10. Increase the /var volume: 

lvextend -L100G <srv-mount-point-of-var> 

For example: /dev/centos/var
11. Increase the file system on /var: 

xfs_growfs /var 

This increases the file system to the maximum space available on volume.

12. Verify that the paritions have the desired sizes: 

df -h

13. Restart the following services: 

systemctl start monit
systemctl start vaisala-radarsw-*

9.4 Upgrading IRIS Focus 3.0 to IRIS Focus 4.0
The following instructions assume you are upgrading from IRIS Focus 3.0 to IRIS Focus 4.0.

If you have previous versions of IRIS Focus, you must upgrade through each
previous version before you can upgrade to IRIS Focus 4.0.

IRIS Focus 4.0 requires a new license. If you do not yet have a license, please
contact your Vaisala sales representative.
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1. Login as root.

2. Backup the system configuration. 
See Making a Manual Back-up (page 83).

3. Download the following files: 

The files are very large. Use a download tool such as CrossFTP that allows
resuming downloads to fetch the packages.

a. IRIS Focus web application package: Vaisala_IRIS_installer-<latest
version>.tar

b. Maps directory: vaisala-iris-maps-v2.zip
c. Terrain data directory: vaisala-iris-terrain-v2.zip

4. Insert the upgrade USB stick.

5. Copy the file Vaisala_IRIS_installer-4.0.tar from the USB stick to the server's
hard disk drive, for example to the /root directory.

6. Extract the following files: 

tar -xvf Vaisala_IRIS_installer-4.0.tar
unzip vaisala-iris-maps-v2.zip 
unzip vaisala-iris-terrain-v2.zip

7. Change to the directory created in the previous step: 

cd Vaisala-IRIS-Focus-v4.0.0--xx

Version 5.3 Administrator Guide M211850EN-H

94 CONFIDENTIAL

http://www.crossftp.com/


8. Run the upgrade script. 
Online upgrade:

./rsw-upgrade --gis-db-dump [maps directory] --terrain-dir [terrain 
directory] --online

Offline upgrade:

./rsw-upgrade --gis-db-dump [maps directory] --terrain-dir [terrain 
directory] --offline

When running the-upgrade script, replace [maps directory] and [terrain
directory] with the correct paths.

To view installation command line options, run: ./rsw-upgrade –h

9. Verify the upgrade by running: rpm –qa | grep vaisala 
Check that the rpm name is version 4.0.

10. Activate the IRIS Focus license. 
Depending upon whether or not your server is connected to the internet, see:

• Activating License – Online (page 41)
• Activating License – Offline (page 44)

9.5 Upgrading IRIS Focus 2.1 to IRIS Focus 3.0
The following instructions assume you are upgrading from IRIS Focus 2.1 to IRIS Focus 3.0.

If you have IRIS Focus 2.0, you must upgrade to IRIS Focus 2.1 before you can
upgrade to IRIS Focus 3.0.

IRIS Focus 3.0 requires a new license. If you do not yet have a license, please
contact your Vaisala sales representative.

1. Login as root.

2. Backup the system configuration. 
See Making a Manual Back-up (page 83).

3. Insert the upgrade USB stick.

4. Copy the file Vaisala_IRIS_installer-3.0.tar from the USB stick to the server's
hard disk drive, for example to the /root directory.
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5. Extract the file: tar -xvf Vaisala_IRIS_installer-3.0.tar 

6. Change to the directory created in the previous step: 
cd Vaisala-IRIS-Focus-v3.0.0--xx

7. Depending on whether you are performing an online or an offline ugrade, run one of the
following:Run: ./rsw-upgrade 

./rsw-upgrade --online

./rsw-upgrade --offline

To view installation command line options, run: ./rsw-upgrade –h

8. Verify the upgrade by running: rpm –qa | grep vaisala 
Check that the rpm name is version 3.0.

9. Activate the IRIS Focus license. 
Depending upon whether or not your server is connected to the internet, see:

• Activating License – Online (page 41)
• Activating License – Offline (page 44)

9.6 Upgrading IRIS Focus 2.0 to IRIS Focus 2.1
The following instructions assume you are upgrading from IRIS Focus 2.0 to IRIS Focus 2.1

IRIS Focus 2.1.0 requires a new license. If you do not yet have a license, please
contact your Vaisala sales representative.

1. Login as root.

2. Backup the system configuration. 
See Making a Manual Back-up (page 83).

3. Insert the upgrade USB stick.

4. Copy the file Vaisala_IRIS_installer-2.1.tar from the USB stick to the server's
hard disk drive, for example to the /root directory.

5. Extract the file: tar -xvf Vaisala_IRIS_installer-2.1.tar
6. Change to the directory created in the previous step: 

cd Vaisala-IRIS-Focus-v2.1.0--55
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7. Run: ./rsw-upgrade 

To view installation command line options, run: ./rsw-upgrade –h

8. Verify the upgrade by running: rpm –qa | grep vaisala 
Check that the rpm name is version 2.1.

9. Activate the IRIS Focus license. 
Depending upon whether or not your server is connected to the internet, see:

• Activating License – Online (page 41)
• Activating License – Offline (page 44)
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10. Security

10.1 Encryption
Communication between the browser and the web application is encrypted.

Other data traffic within the IRIS Focus application server is unencrypted.

IRIS Focus uses Jetty as web server software, and HAProxy for handling HTTPS encryption.
SSL encryption has been disabled in HAProxy, and only TLS encryption is supported.

More information

‣ Web Application (page 23)
‣ HAProxy (page 76)

10.2 Certificates
The web application comes with a temporary, self-signed SSL certificate that secures the
connection between the IRIS Focus server and the user's web browser.

Although the browser displays a security warning in the browser when you try to access the
web application, you can use the application normally even with the warning.

Consider acquiring and using a trusted certificate from a certificate authority (CA), especially if
you plan to offer access to IRIS Focus outside your organization.

More information

‣ Web Application (page 23)
‣ Installing a CA Certificate (page 82)

10.3 Security Settings
The IRIS Focus server has a pre-configured firewall.

Ports for SSH access (22), HTTP (80), and HTTPS (443) are intentionally open:

• Use SSH for configuration
• HTTP port is for redirecting to HTTPS

The application is always used over HTTPS

The server requires access to HTTP and HTTPS for end users. If the system is accessed through
the internet, you should restrict internet access to the SSH port from the internet to improve
system security.
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The firewall is configured through the CentOS firewall system. See https://access.redhat.com/
documentation/en-US/Red_Hat_Enterprise_Linux/7/html/Security_Guide/sec-
Using_Firewalls.html.

More information

‣ Installing IRIS Focus Components (page 37)
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11. Troubleshooting

11.1 Data Manager Does Not Work as Expected
When running correctly, Data Manager and the socket server run continuously.

In some cases, IRIS Focus may be unable to request IRIS Analysis products from the IRIS
Analysis machine through the socket server or IRIS Analysis may be unable to send RAW
products to IRIS Focus. In such cases, try the following solutions.

1. Try shutting down the firewall on the socket server machine: 

service firewall stop

2. Check the product configuration in IRIS Analysis and consider the following: 
• To generate correct centers in IRIS Focus for IRIS Analysis products, IRIS Analysis

must create 1 product for each site on the IRIS Analysis server.
• The IRIS socket server has a limit of 1000 products that can be received by IRIS Focus,

so the socket server provides only the 1000 most recent products.
For example, if IRIS Analysis creates a new product every 15 minutes, IRIS Focus
visualizes only the last 10 days of data. (4 products/hour * 24 hours * 10 days).

• RAW products are only needed for the IRIS Focus Data Manager

3. In the IRIS Analysis Radar Status menu, make sure IRIS Focus is toggled on. 
The toggle button turns on/off the socket server.

4. If IRIS Focus was installed in a system that was already running IRIS Analysis, and the IRIS
Analysis did not have a license that supports connectivity to IRIS Focus, you may need a
new IRIS Analysis license. Request a new license from your Vaisala representative.
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5. To check the delivery of RAW files, make sure Data Manager radarinput is setup
correctly on the IRIS Focus server:

a. On the IRIS Analysis machine, login as root.

b. Type: -- ssh radardminput@the-focus-machine-hostname.com date
c. Make sure the data and time are returned from the IRIS Focus machine without

having to type a password.

d. Check the security keys and permissions: 
• /var/lib/radardminput/.ssh/authorized_keys must be correct
• Permissions must be set to chmod 644 ./authorized_keys

6. Reboot the IRIS Analysis and/or the IRIS Focus servers.

More information

‣ Setting up Data Manager (page 47)

11.2 Data Manager Housekeeping Not Working As
Expected

If the data is corrupted, the application crashes. If Focus is not able to display data, even
though you know that data should be available, the data is probably corrupted. The logs may
also indicate that there has been an error in processing the files.

Use the rsw-data-manager-clear-data script if the Data Manager data storage
becomes corrupt or if there is a need to remove all data from Data Manager.

Running the script deletes all radar data from IRIS Focus, including
Nowcasting configurations, pre-defined composite configurations, and RAW
radar data.

CAUTION!

1. Run the script: 

DM_RESET=yes rsw-data-manager-clear-data

If there is a lot of RAW radar data in Data Manager, it may take some time to run the
script.

Do not interrupt the script execution.CAUTION!
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11.3 Identifying IRIS Focus Software Version
Before contacting Vaisala technical support about an issue, check which version of IRIS Focus
you have on your system.

1. In the terminal window, run: 

rpm -qa --qf '%{NAME} %{VERSION}\n' | grep 'vaisala-radarsw-webapp'

More information

‣ Technical support (page 123)

11.4 Lightning Layer Empty
If the lightning layer exists in your IRIS Focus application but you do not see any lightning
strikes, verify the following requirements:

1. Check that lightning strikes have occurred at the time of observation

2. Check that the configuration file /etc/vaisala/radarsw/configuration/
vsoweb-override.ini contains the following line: 

lightning.wms.url = [URL received from Vaisala]

3. Check that your subscription to Vaisala AviCast GLD360 service is active. 

If you modify the configuration file, you must restart the vaisala-radarsw-
webapp service with the service vaisala-radarsw-webapp
restart command.

11.5 Lightning Layer Missing
If you have subscribed to Vaisala AviCast GLD360 lightning detection service, and you do not
see the lightning layer in the IRIS Focus user interface after running the rsw-lightning-
configure script, add the lightning layer manually.

1. Log in to IRIS Focus with an administrator account and select Admin.

2. Select Map > Map Layers.

3. Select Add New Layer.
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4. In Map Layer Information, enter the following values on the layer properties: 

a. URL: /lightning
b. Layer: lightning:ltg_combined_25
c. Transparent: Checkbox selected

d. SLD URL: https://storm.vaisala.com/geolegends/ltg_combined_25.sld

e. Name: ltg_combined_25.ltg_type
5. Select Save.

6. Select Map > Map View Contexts

7. Edit the default map context TheMap.
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8. Select the newly created lightning layer and set its Z level higher than all base map layers
in the map context. 
Z level defines the drawing order of the layers on the map. Higher values are always
drawn on top.

In the web application, the new layer is listed at the bottom of the radar product selection list.

11.6 Nowcasting is Unavailable
If you cannot see nowcasting features on your display, it is likely because you either do not
have a license or because nowcasting is disabled.

1. Check that you have a nowcasting license.

a. You must have an IRIS Focus seat to use nowcasting. 
If no seats are available, wait until an IRIS Focus seat is available and try again.

b. Login to IRIS Focus as an administrator.

c. Select Admin > Licensing Management.

2. Check that MVF is configured for your site.

3. Log in as root.

4. Go to /etc/vaisala/radarsw/configuration/vsoweb-override.ini.
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5. In the [NOWCAST] section of the vsoweb-override.ini file, check that MVF creation
is enabled in IRIS Focus: 

[NOWCAST]
nowcast.mvf.run = true

By default, MVF generation is enabled (true).

6. Restart the vaisala-radarsw-webapp service by typing: 

systemctl restart vaisala-radarsw-webapp

7. Start the nowcast server by typing: 

systemctl start vaisala-radarsw-nowcast-server

a. To verify that the server starts, type: 

systemctl status vaisala-radarsw-nowcast-server.service

b. Check for the status: 

Active: active (running)

More information

‣ Licensing (page 11)

11.7 Taking a Snapshot Gives Server Error
If, when taking a snapshot or requesting an image via URL, the server times out or gives server
error, there may be a problem with the image-export user account.

1. Check that the application log shows the error: 

Login failed for username image-export

2. Log in as admin.

3. Check that the image-export user password matches the password listed in vsoweb-
override.ini.
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11.8 Online help does not display correctly in
Internet Explorer

If you run the software in Internet Explorer with the compatibility view enabled, the online help
may not display correctly.

To fix the problem, turn off the Display intranet sites in Compatibility View setting.

1. To display the Internet Explorer menu, press ALT.

2. Select Tools > Compatibility View settings.

3. Unselect Display intranet sites in Compatibility View.

4. You may need manage the list under Websites you've added to Compatibility View:

a. Highlight the website address you want to remove.

b. Select Remove.

11.9 Uninstalling IRIS Focus
Use this procedure to recover from a failed installation that is stuck in a state where it cannot
be resumed.

The rsw-uninstaller script completely removes IRIS Focus,
including all data and configurations.
CAUTION!

The rsw-uninstaller script removes Postgres and all
databases.
If you share the system with other software that uses PostgreSQL, do not run
the script -- it also removes PostgreSQL databases not related to IRIS Focus.

CAUTION!

1. Navigate to the directory containing the IRIS Focus installation files.

2. Run: ./rsw-uninstaller 
When prompted, confirm that you want to run the script.
The script removes all users, configurations, and data from the system so that you can
rerun the installation.

More information

‣ Installing IRIS Focus Components (page 37)
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Appendix A. File Locations
Table 13 IRIS Focus Application and Configuration Files

File or Directory Description

/etc/vaisala/radarsw/
configuration

• gis-override.ini
GeoServer database settings.

• logback.xml
Logging level settings.

• radar_centers.properties
List of stored radar site center points.

Configuration files for IRIS Focus module settings.

The files listed here are the most important.

Some settings have a
default config file and an override
file. For example:

• gis-config.ini
• gis-override.ini

When needed, edit the override file.

CAUTION!

/etc/vaisala/radarsw/
configuration/vsoweb-
override.ini

Connection settings for socket server, lightning
layers, nowcasting and so on.

/etc/vaisala/radarsw/nowcast/
nowcast.ini

Configuration files for the nowcast server.

/usr/vaisala/radarsw/
configuration

Configuration files for helper applications used in
IRIS Focus maintenance.

/var/lib/radarweb Home directory of the radarweb user.

The IRIS Focus Web Application is deployed here.

/var/lib/radardm Home directory of the radardm user.

/var/lib/radardminput Home directory of the radardminput user.

/srv/vaisala/radarsw/
datamanager/input

Files sent from an IRIS Analysis machine are copied
here.

The data manager input service processes files
copied here.

/srv/vaisala/radarsw/
datamanager/storage

This is where data manager stores polar or RAW data.

/var/lib/warnreader Configuration files for events and alerts.

/var/log/vaisala/radarsw Log files from IRIS Focus web application
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Appendix B. Map Layer Configuration
Options
Table 14 Map Layer Configuration Options

Option Description WMS Layer Only

Map Layer Information Defines basic map settings, such as the title and the
URL address of the Web Map Service (WMS).

--

Title Title of the layer. Visible in the layer selection list. --

Type • wms: generic GIS services such as base maps or
raster-type forecast data

• google: Google base maps
• marker: observations from stations configured

using the JX source service on the map.

--

URL Address of the WMS service.

Layer Name of the layer in the map server.

If using GeoServer, usually workspace:layer.

--

Base layer Select if the layer is a base map. --

Transparent Select for WMS to request a transparent
background for the layer.

Request as Tiles Use if the map layer should be requested as tiles.

Usually selected for base maps.

MIME type Map image type. Change if the service does not
support the default image/png.

Default opacity
Not used in IRIS Focus.

--

Layer query settings --

Supported 
Coordinate Reference 
Systems

Select supported coordinate reference systems for
the layer.

--

Time Support Configure for layers using time dimensions.

Coverage Maximum bounding box for the layer.

Layer style For advanced configurations, add SLD (Styled
Layer Descriptor) parameters.

--
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Option Description WMS Layer Only

Realtime offset Defines the offset from the current time in which to
make the request for the latest data. Sometimes,
when requesting the latest time from a WMS
service, there is no data available because the WMS
service provider is collecting and processing the
data for the latest time, so it is useful to set an
offset.

Supported values are 0...3600 seconds.

To use this parameter, set the system to always use
time parameter support.

 

Refresh rate Defines the interval of the time ticks on the
histogram. This defines how often the system
makes data requests. The interval always starts on
the hour.

Supported values are 10...86400 seconds.

To use this parameter, set the system to always use
time parameter support.

 

Request width Controls the legend graphic request parameters.

Request height Controls the legend graphic request parameters.

Display height Defines the size of the color legend graphic on the
display in case the original graphic is too large.

More information

‣ Adding and Editing Map Layers (page 72)
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Appendix C. Nowcasting Configuration
Files

C.1. nowcast.ini
The following example shows the nowcast.ini configuration file for configuring the
nowcasting HTTP server.

; Algorithm to use.
correlator=trec 

TREC

[trec]
; Number of decimals to keep in data when converting to integers.
; Range:  [0 ; 3]. Default: 2.
input_precision=2

; The value in image that declares a missing/invalid value.
; Default: -999.0.
missing_value=-999.0

; The value in image that declares a not-scanned pixel, outside the aperture 
area.
; Default: -900.0.
not_scanned_value=-900.0

; Minimum measurement aperture coverage (%) in correlation region.
; Range:  [0.0 ; 1.0]. Default: 0.60.
aperture_coverage_threshold=0.60

; Minimum signal value for the pixel to be 'active' and used.
; Default: 10.0.
signal_threshold=10.0

; Feature box size.
; Range:  > 0 Default: 14
field_feature_box_width=14

; Amount of skip when calculating field values.
; Range:  > 0.  Default: 1 (no skip).
field_feature_box_spacing=1 
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; Minimum fraction (%) of active pixels in feature box needed to trigger 
correlation analysis.
; Range:  [0.0 ; 1.0] Default: 0.10
field_signal_coverage_threshold=0.10

; Minimum allowable cross-correlation coefficient.
; Range:  [0.0 ; 1.0] Default: 0.55
correlation_threshold=0.55

; Maximum storm movement between images, search region radius.
; Range:  > 0  Default: 15
speed_limit=15

; Spatial smoothing factor, exp(-d/decay). Used for spreading effect
; of local motion vector to its surroundings.
; Range:  >= 0 (0 == no spatial smoothing) Default: 6
field_spatial_decay=6

; Spatial filtering flag. Whether to discard points that differ from global 
average.
; Range:  0 == NO; 1 == GLOBAL; 2 == LOCAL . Default: 1(GLOBAL)
field_use_spatial_filtering=1

; Feature box size for local spatial thresholding (applied only when using 
local spatial thresholding).
; Range:  > 0   Default: 9
field_spatial_filtering_box_width=9

; Maximum allowed direction difference from mean motion (applied only when 
using spatial filtering).
; Range: [0 ; 180]  Default: 90
field_spatial_direction_threshold=90

; Maximum allowed speed (mgt*mean_motion) above mean motion (applied only when 
using global spatial filtering).
; Range:  >= 1.0  Default: 3.0
field_spatial_magnitude_threshold=3.0

; Global vector weight applied to local values.
; Range:  [0.0 ; 1.0] (0.0 = no global weighting). Default: 0.25
field_global_weight=0.25

; Method for temporal smoothing.
; Range: 0 == NO_TEMPORAL_SMOOTHING; 1 == HISTORY_WEIGHTING; 2 == 
CHANGE_WEIGHTING.
; Default: 1(HISTORY_WEIGHTING)
temporal_smoothing_method=1
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; History weight factor (applied when temporal smoothing is made by using 
HISTORY_WEIGHTING).
; Range:  ]0.0 ; 1.0]  Default: 0.25
temporal_smoothing_history_weight=0.25

; Change weight factor (applied when temporal smoothing is made by using 
CHANGE_WEIGHTING).
; Range:  ]0.0 ; 1.0] Default: 0.33
temporal_smoothing_change_weight=0.33
 

C.2. vsoweb-override.ini
The vsoweb-override.ini configuration file contains setting for managing the MVF
(motion vector field) product and advection used in nowcasting.

Vaisala has carefully chosen good defaults for the nowcasting configuration.
The raster product, such as PPI, CAPPI, of any intensity moments like Z, R, KDP, or
rhoHV that is used as an input for MVF generation should have:

• As little as possible of ground clutter and the near-radar clear air or
particulates (such as dust) returns.

• The bounding box not smaller than any other raster product produced from
this site's data.

Because the two conditions are contradictory, the easiest way to satisfy first
condition is to use a true (not pseudo) CAPPI product with a height of 1.5 ... 2km ,
but the longest range (biggest bounding box) product is a raster product
generated from the survey scans, which usually consist of just one PPI scan and
cannot be used to generate true CAPPI products. You must balance these two
conditions.

If there are not enough valid products to generate an MVF request, the iteration is
skipped and the system waits for the next product to arrive from IRIS.

Basic Settings

nowcast.mvf.run defines if MVF generation is enabled in IRIS Focus. By default, MVF
generation is enabled (true).

[NOWCAST]
nowcast.mvf.run = true

The nowcast server URL dentifies where the nowcast HTTP server runs. The default value is for
a fully local installation, which is the default installation configuration.
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nowcast.http.server.url = http://localhost:34480/api/v1/mvf/

The netCDF directory stores MVF generation requests and responses to the Nowcast HTTP
Server in netCDF format as well as internal representations of MVF serialized to disk. This
directory is cleaned periodically by default.

nowcast.netcdf.dir = /srv/vaisala/radarsw/product/nowcast/

Advanced Settings

nowcast.mvf.request.num.rasters defines the number of products sent to the
nowcast server for generating the MVF. Default is 2.

nowcast.mvf.request.num.rasters = 2

nowcast.mvf.product.age.limit.minutes defines the maximum number of minutes
(5 ... 1000) the system goes back in time to find valid products (of the type used to define MVF
generation for a site) to use in generating the MVF. Default is 100.

nowcast.mvf.product.age.limit.minutes = 100

nowcast.mvf.max.gap.minutes defines the maximum acceptable gap in minutes
(1 ... 1000) between products for MVF generation. Default is 30.

MVF is a shift in pixels per time interval between frames of the product which was used to
generate MVF. The interval between advected products may be different from the interval
between advected frames. For example, if MVF was generated from the product which was
available every 5 minutes but the interval between advected frames has to be 10 minutes, the
MVF shift should be doubled. That MVF scaling is taken into account by a scaling shift in every
iteration.

nowcast.mvf.max.gap.minutes = 30

nowcast.product.times.age.limit.minutes defines the time range for calculating
advected product times (2 ... 2880 mininutes. 2880 is the entire two-day range). Default is 100

Advected product times must be evenly spaced (due to the calculation). The time is derived by
dividing the last number of minutes defined in this property by n products found in that
period.

The spacing is used as the time gap between advected products. In most cases, set this value
to match the value in nowcast.mvf.product.age.limit.minutes.

nowcast.product.times.age.limit.minutes = 100
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nowcast.advection.mvf.age.limit.minutes is the maximum number of minutes to
go back in time to find an MVF when generating advected products. If an MVF is not found in
the time span given, the iteration is skipped and Focus waits for the next product to arrive
from IRIS. Range: 5 ... 1000 minutes. Default is 30.

nowcast.advection.mvf.age.limit.minutes=30

nowcast.advection.time.span.minutes defines the time limit when extending
nowcasted products into the future (minutes). The normal range is 1 ... 3 hours. Default is 120.

You can raise the time span to up to 6 hours but this is not recommended as accuracy
decreases as time extends into the future.

nowcast.advection.time.span.minutes=120

Version 5.3 Administrator Guide M211850EN-H

114 CONFIDENTIAL



Glossary

advection
The transfer of a property of the atmosphere, such as heat, cold, or humidity, by the
horizontal movement of an air mass. Advection calculations are used to perform some of
the nowcasting calculations.

alarm
An alarm is an alert of highest severity.

alert
Alert is a state that requires user intervention or recognition. Different types of alerts
include alarms, warning, and informational alerts.

area of interest
An area of interest is a geographical area that is monitored for certain weather events. If
the system detects a weather event in an area of interest, it generates an alert.

bin
A single sample of weather data detected at a known direction, altitude, and distance
from the radar site. The radial size of a bin increases with distance, so bins further from
the radar site cover a larger area than nearby bins.

composite
Composites combine data (for example, a group of CAPPI, VIL, PPI, or TOPS products)
from many radars in one image.

data manager
The raw volume data from the radar signal processor is stored in the data manager,
which makes the data available to the IRIS Focus user interface. Through the data
manager, IRIS Focus can read raw volume data and generate on-demand radar products
in real-time.

dynamic composite
A radar composite of on-demand products created by selecting multiple radar sites on
the fly. The combining criteria are based on standardized settings.

event
Event is a record of a momentary change of state or an occurrence produced by a source
or some other entity. An event can indicate an error or a warning or can be just for
information.

hybrid task
A group of up to 3 tasks with the same scan type which are scheduled together and used
together to make products. This allows flexibility of volume scanning schemes.

hydrometeor
A particle of condensed water vapor in the atmosphere. Rain, snow, and hail are
examples of hydrometeors.
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Max Time Span
Max Time Span is the maximum time (minutes) allowed between the newest and oldest
points of data. When new data is processed, points that are older than the specified time
span are removed. Used in, for example, composites of radar data.

MSL
Mean sea level. An average level for the surface of the sea or ocean.

NDOP product
Dual-Doppler velocity product. Combines the velocity measurements from 2 or more
radars to get the wind direction and speed.

nowcasting
Weather forecasting up to the next 2 hours.

NWP
Numerical weather prediction

on-demand product
On-demand products are based on raw data from the IRIS back-end. IRIS Focus reads
raw volume data and generate radar products in real-time. Users can manipulate product
criteria in the user interface in real time.

pin
Pins on a map indicate points of interest with reference points and labels.

place of interest
A location on the map that is either a single point (pin) or a larger area. See area of
interest and pin.

pre-configured products
Pre-configured products are products with default settings used for advanced data
visualization such as nowcasting, warnings, or multilayer products.

pre-defined composite
A pre-defined radar composite with customized settings such as the combining
algorithm.

PRF
Pulse Repetition Frequency measured in Hz (pulses per second). When measuring PRF, a
pulse contains transmit, receive, and dead time phases. PRF affects range folding and
velocity folding detection. Normal PRF values for Doppler radars are up to 1000 Hz.
Vaisala radars generally operate around 400-700 Hz. In Vaisala IRIS products, PRF limits
the area displayed in radar images and the maximum measurable wind speed.

product
Radar products are raw signal data from a radar receiver processed to provide
information about current weather conditions. Radar products are calculated from ingest
files that are collected during the execution of radar tasks. Products may be data,
pictures, or text. For example, PPI and RHI.
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pulse
A short burst transmission signal sent by the radar, used to measure the weather activity
in atmosphere. The reflection measurements from a pulse are sorted into bins.

radar product
See product.

range folding
Detection of the 2nd trip echoes, which are radar signal echoes from outside the radar
maximum range. Range folding causes them to be incorrectly displayed within the radar
measurement area. Also called range aliasing.

RAW product
Spherical coordinate data product obtained directly from the raw ingest data. The data
are stored in compressed format so they can be recorded on tape or sent to a
workstation for further processing.

ray
A group of pulses processed together according to configuration rules. See also pulse.

signal processor
A programmable device for digitizing and processing video signals from the radar
receiver.

sweep
A collection of pulses at a constant elevation as the radar rotates around its axis 360°.
After a sweep, the radar usually changes its elevation and starts a new sweep. Each
sweep typically contains the same number of bins independent of the elevation.

task
A set of instructions to the radar and signal processing systems including, but not limited
to, the scan type (PPI or RHI), PRF, pulse width, signal processing data types, time and
range averaging criteria. For example, a PPI volume scan at multiple elevation angles or
an RHI at a single azimuth. Also called radar task.

velocity folding
Erroneous readings due to particles in the measurement area exceeding the maximum
velocity detection threshold of the radar system. The measured velocity "wraps around"
to the other end of the scale, resulting in discontinuous readings. Also called velocity
aliasing.

volume
Complete set of raw measurement data collected from sweeps, that is used to calculate a
model of the atmosphere. The maximum volume is half of a sphere (from 0° elevation
upwards), but other shapes are more typical.

warning
A warning is an alert of medium severity.
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Warranty
For standard warranty terms and conditions, see www.vaisala.com/warranty.
Please observe that any such warranty may not be valid in case of damage due to normal wear
and tear, exceptional operating conditions, negligent handling or installation, or unauthorized
modifications. Please see the applicable supply contract or Conditions of Sale for details of the
warranty for each product.

Technical support

Contact Vaisala technical support at helpdesk@vaisala.com. Provide at least the
following supporting information as applicable:

• Product name, model, and serial number
• Software/Firmware version
• Name and location of the installation site
• Name and contact information of a technical person who can provide further

information on the problem
For more information, see www.vaisala.com/support.

Recycling

Recycle all applicable material.

Follow the statutory regulations for disposing of the product and packaging.
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